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 EUROCUT PROFESSIONAL 

Important Customer Information 
about EuroVECTOR 
Please check the contents of your software package as soon as 
possible upon receiving it. Should any items be missing, 
immediately contact the dealer from whom you have purchased 
the software. 
 
A complete package of EuroVECTOR should contain the 
following items: 
 
• 1 program CD 
• User manual 
• Registration card 
 
You will find your personal code (e.g. 1A1A-AAAA-2222-3333-
B2B2-CDEF). This code number must be entered upon 
successful installation and initial startup of the software. Make 
sure you enter the number correctly, or you will not be able to 
start the program. 
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Dear Customer, 
 
In an effort to help you solve any problems and answer your 
questions as quickly and efficiently as possible, we provide our 
Technical Support Line. This is a toll-free number you can call if 
you have any technical questions about our products. 
 
This service is available to you free of charge. 
 
Mon. - Fri. from 9.00 am to 12.00 am 
 
Horst Krämer Tel. ++49 6502 9288 11 
 
You can find further useful information including tips and tricks 
on our web site: 
 
h t t p : / / w w w . e u r o s y s t e m s . l u  
 
under the rubric Support/FAQ. 
 
Our support staff have been instructed only to provide assistance 
to registered users.  
 
When calling, faxing or e-mailing, please provide the following 
information: 
 
- Serial number of your EUROSYSTEMS product 
- Version number, i.e. EuroVECTOR 
- Printout of your product’s data 
- (Help / About...) 
 
Please understand that we can only answer enquiries addressed 
to this telephone number. Other telephone numbers are reserved 
for marketing, purchasing and sales. 
 
In order to obtain the best possible technical support, we urge 
you to register your software. Immediately upon receipt of your 
registration card by fax or online, you will be entered in our 
Customer Support database. 
 
RCS Systemsteuerungen GmbH 
General Distributor for EUROSYSTEMS products. 
 
P.S.: For written enquiries or quick registration by fax or  
online, please use the following number or address: 
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Fax: ++49 6502 9288 15 
 
Web site:  http ://www.eurosystems. lu 
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Copyright 
Copyright©2004 by EUROSYSTEMS S.à.r.l., Luxembourg.  
All rights reserved. 
The EuroVECTOR software for Windows and this publication are 
licensed property of EUROSYSTEMS S.á.r.l, Luxembourg, 7, rue 
de Tanneurs, L-6790 Grevenmacher. 
Any reproduction or transmission in any form, by any method or 
for any purpose of the software or of this manual, in whole or in 
part, is strictly prohibited. 
 
User manual text/ typesetting/ layout: 
Georg Wagner, Peter Bettendorf  
EUROSYSTEMS 
English translation: Hilary Teske  
 
This software is licensed for the exclusive use of the original 
purchaser and is to be used on one computer system only. 
Similar to a book, this software can be moved from one location 
or computer to another, as long as there is no possibility of it 
being used at two locations, or by more than one person, 
simultaneously. 
 

Limitation of Liability 
 
Utmost care has been taken in the compilation of this manual and 
the text and illustrations therein; however, no guarantees can be 
made as to the completeness or perfect accuracy of the manual 
or the program itself. 
In no event shall EUROSYSTEMS, its dealers or distributors, be 
liable for lost profit, data, or information of any kind, or for any 
special, collateral, incidental, consequential, indirect, punitive, or 
any other type of damages in connection with or arising out of 
purchase or use of EuroVECTOR or its documentation. The 
information contained in this manual is subject to change without 
notice and does not represent a commitment on the part of the 
vendor. 
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Trademarks 
 
Adobe Type Manager, AMD, Intel, CorelDRAW, Postscript, 
Microsoft, Windows, and other brand or product names used in 
this manual are trademarks or registered trademarks of their 
respective holders/ manufacturers.  
 
December 2003 
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About This Manual 
You have acquired EuroVECTOR together with this manual. This 
version includes a large number of new functions which allow you 
to design and create top-class artwork more easily. 
 
The first chapter How to Install EuroVECTOR explains how you 
install EuroVECTOR on your computer. Please follow the 
installation instructions closely, as you cannot work properly with 
EuroVECTOR unless installation has been correctly carried out. 
 
The second chapter How to Work with EuroVECTOR is an 
introduction to its mode of operation. 
 
The Reference Section in Chapter 3 explains all the menus and 
their items in chronological order. 
 
You should refer to this section when you are not exactly sure 
about how a command works. 

Hardware and Software Requirements  

• The minimal requirement is a Pentium 300 with 128 MB of 
RAM. 

• Windows 98SE or later version 
• Video display running at 800 x 600 pixels with 16  
 colors 

User Manual Format 

To make this manual more easily readable, the same symbols and 
type styles are used throughout. The following is an explanatory 
chart designed to help you find and interpret these visual aids 
more easily. 
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Visual Aid Chart 

 
Symbol / Type Style Interpretation 
 
Bold Headings 
   
Italic Notes 
 
Bold, italic Menus, e.g.: File Menu 
 
Bold, italic Tools, boxes, options, 

commands, icons,  
 e.g.: New command 
 
CAPITALS Keys, e.g. SHIFT 
 
KEY1+KEY 2 The plus sign (+) between two 

keys means that you have to 
hold down the first key when 
you press the second key. 
Then you release both keys. 

 
KEY1,KEY 2 A comma (,) between two keys 

means that you press the keys 
one after the other and release 
them. 

 
 Shortcut 
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Introduction 
Along with this manual, you have received the latest version of 
EuroVECTOR. This Software gives you the capability to easily 
and accurately reproduce logos, symbols, and similar graphics. 
Depending on your application, you may choose to digitize or to 
vectorize the original graphic. To edit or manipulate the resulting 
file, a variety of tools are at your disposal. 
 
Whether you are new to sign-making or consider yourself an 
expert, EuroVECTOR gives you all the tools you need for 
professional results. 
 
You will soon realize just how powerful EuroVECTOR is, whether 
your application is display or vehicle graphics, signmaking or 
exhibit building. You may be involved in screen printing, vehicle 
lettering, or stencil cutting EuroVECTOR is equally capable of 
handling any of these tasks. And there are many more 
applications: e.g. 
 
Before you begin working with EuroVECTOR Professional, you 
should be familiar with the basics of operating your PC and 
Microsoft Windows. 
 
A detailed description of the required procedures can be found 
in your Microsoft Windows manual. 
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1. How to Install EuroVECTOR 
 
EuroVECTOR V.2 comprises one CD. 
 
Step 1: Windows 98SE, ME, NT, 2000 & XP: 
 Place the CD in the CD drive. 
 Select Execute in the Start menu if the automatic 

autostart do not start. 
 
Type D:\setup or c :\setup in the command line, depending on 
the name of your CD–ROM drive.  
 
After a short time a window entitled “EuroVECTOR Setup“ 
appears. 
 
Use the Continue button to proceed with the installation routine. 
 
“EUROSYSTEMS Licencing Agreement“ Dialog Box 
 
Once you have accepted the conditions of the EUROSYSTEMS 
licencing agreement, the actual installation starts. 
 
“Select Target Path“ Dialog Box 
 
In this dialog box you can select the directory in which 
EuroVECTOR is to be installed. 
C:\Programfiles\EUROSYSTEMS\EuroVECTOR 2 is the default 
suggestion. 
If you wish to install EuroVECTOR in another directory, please 
activate the Search button enter the desired target directory 
under Path and in the dialog box which appears. 
 
“Type of Setup“ Dialog Box 
 
There are three ways of installing EuroVECTOR. 
 
1. Standard: EuroVECTOR is completely installed without the 

Engrave command (recommended). 
 
2. Minimal: Only the essential functions of EuroVECTOR are 

installed. 
 

!!!! 
Please follow 
these 
instructions 
carefully to 
ensure 
EuroVECTOR 
is correctly 
installed 
 
 
 
 
 
 
 
 
Licencing 
Agreement 
 
 
 
 
Target Path 
 
 
 
 
 
 
 
 
 
Type of Setup 
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3. User: EuroVECTOR is installed according to the user’s 
specifications, i.e. the user can select the options 
they consider to be important (only for 
experienced users). 

 
“Select Program Folder“ Dialog Box 
 
Here the EUROSYSTEMS/EuroVECTOR folder is the default 
suggestion. You can define a new program folder in the 
Program Folder command line.  
 
After this you will be asked, if you want install an link on your 
desktop. Confirm this dialog and the prgramm files will be 
copied. 
 
Dialog „InstallShield Wizard finished“ 
 
Activate the Start EuroVECTOR 2–option and press the 
Completion-Button the folllowing dialog will be opened. 
 

 

Abb. 1: The EuroVECTOR Start-Dialog 

Confirm the licence-button the following dialog will be opened. 
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Fig. 1: Der EuroVECTOR Lizenz-Dialog 

All input fileds must be filled out. The input data of the fields 
company and eMail you filled out the first time must be the 
same if you installed EuroVECTOR once more. 
 
You personal codenummer you will find in your manual your 
invoice or your delivery note. 
 
After you enter your personal code number EuroVECTOR will be 
started. 
 
Close all application and restart your computer. 
 
By double clicking the EuroVECTOR-Icon in the 
EUROSYSTEMS-Group you will start EuroVECTOR  
 
EuroVECTOR works ! 

Construction of label: 
1. Company Name 
2. eMail-Adress 
2. Serial Number 
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2. How to Work with EuroVECTOR V.2 
In this chapter you will learn the basics of working with EuroVECTOR. You will be 
introduced to such items as the desktop, the tools, the text editor, data import and 
export, loading and saving jobs and also cutting. 

2.1 Your Desktop with the EuroVECTOR Working Area 

After EuroVECTOR has been started, the following window appears: 
 

 

Fig. 2: The EuroVECTOR Desktop and Working Area 

The Rulers can be positioned freely as you wish or completely turned off. The Color 
Layerbox can be positioned wherever you like on the working area. The default 
position is at the left edge of the working area. 
 
The Units of Measurement (cm, mm, inch) can be changed by simply clicking a 
button. The button is located in the lower right corner where the horizontal and 
vertical scroll bars meet. 
 
In the Status Bar there is extensive information about the objects to be found in 
your working area, such as wireframe, fill, dimensions, number, combination or 
grouping. 
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2.1.1 The EuroVECTOR Program Line 

The various elements of the EuroVECTOR program line are described in the figure 
below. 
 

 

Fig. 3: The EuroVECTOR Program Line 

Underneath the program line is the menu line, whose various menu items are 
described in detail in Chapter 3, Reference Section. 

2.1.2 The EuroVECTOR Standard Toolbar 

You can turn the Standard toolbar on and off via the Window menu or the shortcut 
CTRL+1. 
 

 

Fig. 4: The EuroVECTOR Standard Toolbar 

2.1.3 The EuroVECTOR Setup Toolbar 

You can turn the Setup toolbar on and off via the Window menu 
or the shortcut CTRL+3. 
 

 

Fig. 5: The EuroVECTOR Setup Toolbar 
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2.1.4 The EuroVECTOR Toolbox 

You can turn the Toolbox on and off via the Window menu or 
the shortcut CTRL+4. 
 

 

Fig. 6: The EuroVECTOR Toolbox 

2.1.5 The EuroVECTOR Object Attributes 
Toolbar 

You can turn the Objects Attributes toolbar on and off via the 
Window menu or the shortcut CTRL+7. 
 

 

Fig. 7: The EuroVECTOR Objects Attributes toolbar 

2.1.6 The EuroVECTOR Color Layerbox 

The color layerbox can be used to color objects, define different 
vinyl colors, select objects of specific colors and block certain color 
lavers or make them invisible. You can turn the color layerbox on 
and off via the Window menu or the shortcut CTRL+2. 
 

 

Fig. 8: The EuroVECTOR Color Layerbox 
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2.1.7 The EuroVECTOR Clipart Toolbar 

The Clipart toolbar can be used to manage your clipart. In this 
way you can quickly and easily import clipart from any group of 
images to your EuroVECTOR working area and edit it. 
 
You can turn the Clipart  toolbar on and off via the Window 
menu or the shortcut C. 
 

 

Fig. 9: The EuroVECTOR Clipart Toolbar 

2.1.8 Explanation of Cursor Shapes in the Working 
Area 

Cursor shape Interpretation 
 

 No object selected 
 
Note: Select objects by positioning the mouse cursor on the 
object and pressing the left mouse button. 
 
Cursor shape Interpretation 
 

 Move objects  
 
Note: This type of cursor is only active when the cursor is located 
in the interior of the object or in the area between the 8 black 
squares on the wireframe. The object must be selected. 
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 Enlarge object vertically 
 

 Enlarge object horizontally 
 

,   Enlarge object diagonally 
 
Note: The cursors for modifying the size of objects are only 
active when the cursor is located in the area  between the 8 black 
squares on the wireframe of the object. 
 
You can switch to the Skew/Rotate mode by clicking once on 
the left mouse button with the cross cursor activated. 
 
Cursor shape Interpretation 
 

  Object in Skew/Rotate mode 
 

, , , , Rotation of objects 
 

,   Skewing of objects 
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2.2 The EuroVECTOR Tools 

The first time you start EuroVECTOR, you will find the toolbox in 
the upper left corner of your screen. It contains 7 icons. 
 

 

Fig. 10: The Toolbox  and its Fly-Out Menus 

a. Fly-out menu for the Drawing Tools 
b. Fly-out menu for the Zoom Tools 
c. Fly-out menu for the Fill Tools 
d. Fly-out menu for the Pencil Tools 
 
Note: The tools can be turned on and off via the Window 
menu/Tools.  

2.2.1 The Arrow Tool 

 

Fig. 11: The Arrow Tool 

The arrow tool, also known as the general work tool, is used to 
select, move, temporarily group (using the Frame box) and resize 
text or objects. 

Select  

Click on any point of the object and it is automatically selected, 
i.e. a frame defined by eight small squares appears around it. 
When working in the Edit Wireframe (F9) mode, you must click 
on the outline of the object to select it. 
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Note: To select individual letters in a text string, the text must first 
be converted to a bitmap by using the Text to Curves command 
in the Edit menu. The selected letter(s) can then be detached 
from the string by pressing SHIFT+L. 

Resize 

You can proportionally resize objects by grabbing one of the 4 
handles or corner squares of the frame around the object. 
Double-clicking on one of these corner squares opens the 
Object Attributes... dialog box in which you may enter specific 
values under Size. 
To resize an object non-proportionally, double-click on the 
squares located between the corner markers. 
To resize by eye (proportionally or non-proportionally), simply 
click on the appropriate square and drag it until the desired size 
has been obtained. 

2.2.2 The Node Editing Tool 

The node or point editing tool lets you Move, Add, Join, Break, 
Align,… nodes or points. 
 

 

Fig. 12: The Node Editing Button 

Click on the node-editing button (the cursor changes its shape) 
and subsequently on a point of the object or text string. 
 
The text or object is now displayed as follows: 
 

 

Fig. 13: An Object in the Node-Editing Mode 

Tip: By hitting the SPACE BAR on your keyboard, you can easily 
switch back and forth between the arrow tool and the node-
editing tool. 
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All corner points are displayed as squares, while all points on a 
curve are displayed as circles. The latter are in fact called 
tangential points. 
The starting point of the object is displayed as a double square (a 
smaller square inside a larger one). 
 
To select individual nodes or tangential points, simply click on 
them with the node-editing tool. To indicate selection, the points 
are bolded (filled in). It is thus easier to recognize selected  
nodes or tangents, which considerably facilitates node editing. 
You can click on the different points and move them by pressing 
down the left mouse button. 
Moving a tangential point will reshape the corresponding curve. 
 
Note: To select multiple points, click on the first point, then hold 
down the SHIFT key while continuing to click on the other points. 
The same can be achieved by clicking a short distance away from 
the first point and dragging a frame around it and all other points 
you wish to select. 
Double-clicking on a node activates the Node Editing dialog 
box. 
 
The node-editing dialog box can be pinned firmly on the 

EuroVECTOR working area using the   Pin icon When the 

Pin icon is activated the pin turns into the symbol  and the OK 
button becomes an Assign button. 
 
Note: When you have pinned the Node Editing and Object 
Attributes... boxes firmly to the working area, you can switch 
back and forth between the boxes by hitting the SPACE BAR. 
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Fig. 14: Node Editing Dialog Box 

Note: To edit the nodes in a text string, you first have to transform 
the nodes to an image using the Text to Curves command, 
otherwise the text string will be displayed with dotted blue lines. 
 
You can recall the most frequently required node editing 
commands via the right mouse button. 
 
The right mouse button commands change depending on 
whether one or more nodes are selected. 
 
If two nodes are selected, the right mouse menu appears as 
follows: 
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Fig. 15: The Right Mouse Menu With Two Nodes Selected 

If only one node is selected, the following menu items are 
available: 
 

 

Fig. 16: The Right Mouse Menu With One Node Selected 

Note: You can select several nodes by holding down the SHIFT 
key and clicking on the nodes you wish to select one after 
another. 
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Round Nodes (inside/outside) 

 

Fig. 17: Rounding Nodes 

The following settings are available to you in the Round dialog: 

Round outside corners 

When this button is activated, the selected nodes/corners or the 
whole object will be rounded outside by the radius indicated, 
depending on which option is chosen. 

Round inside corners 

When this button is activated, the selected nodes/corners or the 
whole object will be rounded inside by the radius indicated, 
depending on which option is chosen. 
The radius for rounding the nodes can be specified in the box on 
the right next to the button mentioned above. 
The option For Narrow Objects is located below the Round 
button. 
Two options are available to you. 
If you select Use Small Radius, EuroVECTOR calculates the 
appropriate radius for rounding the nodes on this narrow object. 
 
If you select Do not round, the nodes on narrow objects are not 
rounded. 
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Reduce Nodes 

When this command is activated, any redundant nodes will be 
removed, i.e. the nodes which do not affect the shape of the 
curve are removed. 
 
Note: The Reduce function always affects the whole object. 

Symmetric 

This command is used to make the tangents of any point perfectly 
symmetric, i.e. the two tangents of any curve point will form a 
straight line and be of equal length. When moving such a node, 
the symmetry will not be affected in any way. 

Cusp 

The Cusp command cancels the symmetry of the tangents, thus 
allowing you to change them individually. The shape of the curve 
is not directly affected by the initial selection of this option. 

Smooth 

This option is used to smooth points in a curve or wherever a 
straight line turns into a curve. The tangents of these points are 
adjusted so that they form a straight line, thus creating a perfectly 
smooth curve or curve/straight-line transition for best possible 
output quality. The adjustment of the tangents is always kept to a 
minimum. 
This feature is especially useful after moving a point on a curve. 
Because any move causes the tangents to lose their orientation 
to one another, the Smooth function must be used to readjust 
the tangents to form a straight line. Again, this is a very important 
editing feature in that it will determine the quality of your output 
when you send it to your plotter/cutter. 
 
Note: The Smooth option is not available when there are 
straight lines on both sides of the selected points. When two 
tangential points of a curve are moved, they are no longer 
symmetrically aligned in relation to each other. The Smooth 
command transforms them into a straight line again. 

Origin 

For routing applications it is important to be able to control the 
point at which the bit first plunges into the material.  
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This option allows you to change the starting point of a selected 
contour, which is of particular importance for routing and 
engraving applications. For this type of cutting, it is important to 
be able to control the point at which the bit first plunges into the 
material. To change the starting point of a contour, double-click 
on the new starting point you have selected. Choose Origin in 
the node editing panel, and the selected point is turned into the 
new starting point. As such, it is displayed as a double square. 

Break 

This command is used to break up or dissolve a single point into 
two separate points. Each of the new points will receive one of 
the tangents of the original point. When applied to a closed 
contour, this function will create two new points that become the 
starting points for two open contours. 
Select the point you wish to break. Double-click on it to activate 
the node-editing panel. Click on Break. 

Join 

This function, which joins two points, is used primarily to close 
open contours. The points to be joined must be located at the 
end of a segment or contour. With the node-editing tool, select 
the first point. Then hold down the SHIFT key and select the 
second point, i.e. the point you wish to join with the first. Selected 
nodes are displayed with a black fill and the status bar shows you 
how many objects have been selected. Finally click on the Join 
button. 
 
Note: There is another option available for closing contours: the 
Frame function. With the left mouse button held down, draw a 
line linking the selected points. It is only possible to join two 
selected points when they are both at the ends of an open 
contour.  

Delete 

To remove or delete nodes from your contour, you have the 
following options: 
 
-Select the point you wish to delete. Double-click on it and 
choose the Delete command in the node editing panel. 
Or, more efficiently: 
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Select the point you wish to delete. Press the DELETE button on 
your keyboard. 
 
When deleting an end-point of an open contour, the adjoining 
nodes will be connected with a curve, provided there was at least 
one curve on either side of the deleted point. 
 
However, if there were no curves on either side of the deleted 
point (in other words, if you deleted a node on a straight line), the 
adjoining points will be connected with a straight line. 

Add 

This function is used to add additional points to a contour line. 
Use the node editing tool to double-click at the exact location on 
the line or curve where you wish to insert a point. Click on Add in 
the Node Editing panel that appears on the screen. A new point 
has now been added to your contour. 

Curve 

This command is used to convert straight lines into tangential 
curves. Use the node-editing tool to select the line you wish to 
convert and double-click on it. Choose the Curve command in 
the node-editing panel and the straight line will be converted into 
a curve.  

Line 

This command is used to convert curves into straight lines. Use 
the node-editing tool to select the curve you wish to convert and 
double-click on it. Choose the Line command in the node editing 
panel and the curve will be converted into a straight line.  
Note that all curve attributes will disappear when a curve is 
converted to a straight line. 
This function is used to vertically or horizontally align nodes or 
points. You must select at least two points to perform this task. 
With the node-editing tool, select the first point. Then hold down 
the SHIFT key and select the second point, i.e. the point you wish 
to align with the first one. 
Double-click on the reference point, i.e. the point with which you 
want the other selected point(s) to be aligned. Now select either 
the horizontal or vertical Align icon in the node-editing panel. 
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Align Corners 

Aligning corners is a further possibility of aligning nodes or 
points. This function aligns nodes which are positioned almost 
vertically or horizontally in relation to the preceding and following 
nodes. 
 
Aligning corners is a combination of horizontal and vertical 
alignment. 
Right angles can be created very quíckly using this method. 
 
 

  
Fig. 18: Aligning Corners 

Fig. 18 shows how Align Corners is performed. The original 
state of the rectangle can be seen in the illustration on the left. 
Select the lower left corner and open the Node menu by double-
clicking on the corner. The corner point will be aligned 
horizontally and vertically with its adjacent points. This creates a 
right angle, as illustrated in the diagram on the right. 

Direct Input of Coordinates for Node Positions 

In the Position (mm) combobox you can position nodes by 
entering their X/Y coordinates. A distinction is made here 
between absolute and relative values. 

Absolute Values 

When absolute values are entered the value is assigned to the 
selected node. 

Relative Values (with SHIFT key) 

When relative values are entered, the selected node is moved in 
a horizontal or vertical direction by the amount specified in 
relation to the selected node, i.e. the coordinates entered are 
added to the original coordinates. 
 
Procedure: 
First enter the desired coordinates and then hold down the 
SHIFT key while you click the Move button. 
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Horizontal/Vertical Restraint in Moving 
Lines/Curves 

Lines can be restrained vertically or horizontally by holding down 
the SHIFT key, i.e. it is only possible to move the line in one 
direction. 
 

 
 original moved 

Fig. 19: Moving Lines 

When lines are moved, the shape of the curve changes. The 
change in shape depends on the point chosen to carry out the 
action, as can be seen in Fig. 20. 

 

Fig. 20: Moving Curves 

Keys for node editing are also available on the keyboard. 
 
The node attribute smooth is automatically saved when the 
current and following node form a curve. 
 
Note: The magnifying glass function can also be used in the 
node editing mode. 

Align Corners 

This command joins two nodes with two “smooth“ lines. 
Any nodes situated between the two selected nodes will be 
deleted. 
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Fig. 21: Example of Aligning Corners 

This command joins two nodes with two “smooth“ curves. 
Any nodes situated between the two selected nodes will be 
deleted. 
 
If one of the selected nodes is situated at a corner the original 
angle will be retained. 

Round Corners 

 

Fig. 22: Example of Rounding Corners 

It can be seen in the figure above that the left outside edge of the 
G needs modifying. To do this, select the nodes above and below 
the “fault“. If you activate the Round Corners command, the 
nodes situated between the selected nodes will be deleted and 
the two points joined with a curve. 
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You can see in the figure below that the selected points are 
situated on parallel lines. If this is the case, the selected nodes 
will be joined with a semi-circle. The nodes situated between the 
selected nodes are deleted. 

Join With Straight Line 

This command joins the two nodes selected with a straight line. 
Any nodes situated between the selected nodes are deleted. 
 

 

Fig. 23: Example of Joining Nodes with a Straight Line 

Join With Curve 

The two selected nodes are joined with a curve. 
Any nodes situated between the selected nodes will be deleted. 
 

 

Fig. 24: Example of Joining Nodes with a Curve  

Align Object Horizontally/Vertically 

The object in which the nodes are selected is aligned either 
horizontally or vertically. 
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Fig. 25: Align Object Horizontally 

 

Fig. 26: Align Object Vertically 

Reduce Nodes... 

When you activate this command, the Reduce Nodes dialog box 
appears where you can make the following settings: 
 

 

Fig. 27: Dialog Box for Setting the Accuracy of the Node 
Reduction  
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Accuracy 

This value affects the conversion of lines to Bezier curves. The 
greater the deviation is the smaller the number of curve 
commands that will be needed to recreate the original arc of the 
curve.  

Create Curves With Angle Larger Than – X - Degrees  

If the angle of the lines at one of the nodes is smaller than this 
value, the arc of the curve will be interrupted at this node. 

Create Straight Line With Deviation Smaller Than – X – 
Degrees 

If a curve is created with an arc lying within the tolerance value, it 
will be converted to a straight line. 

Node Selection 

TAB Select next node  
TAB + SHIFT Select next node additionally 
BACK Select previous node 
BACK + SHIFT Unselect most recently selected node  

Interactive Rounding or Aligning of Corners 

If you click on the arc of a curve with the CTRL key held down, a 
node will be inserted at this place. This node serves to select the 
position of the rounding. When the second node is selected, you 
can align, round or perform any other node-editing command you 
wish. 

2.2.3 The Zoom Tool  

This tool is used to zoom in and out on your desktop, working 
area or design. 
 

 

Fig. 28: The Zoom Tool Icon 

When you click on the Zoom icon, a flyout box appears 
containing five additional icons. 
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Fig. 29: Flyout with 5 Zoom Functions 

The icon with the plus sign is used to enlarge a selected area of 
your desktop. Using the framing tool, draw a frame around the 
area you want to enlarge. You can repeat this procedure several 
times for further magnification.  
An acoustic alert will warn you when you have reached the limit 
and no further magnification is possible. 
 
Note: You can also execute this command by pressing F2 and 
the + (plus) key in the numeric keypad. 
 
The icon with minus sign is used to reduce the size of a selected 
area of your desktop or working area. 
 
Note: You can also execute this command by pressing F3 and 
the - (minus) key in the numeric keypad. 
 
The icon depicting a sheet of paper is used to view the working 
area in its entirety.  
The icon depicting a monitor is used to display all objects on your 
working area. 
EuroVECTOR will enlarge or reduce the objects to make just 
enough room for everything to fit on your screen. 
 
The last icon depicting a magnifying glass is used to display all 
selected objects in the maximum possible size. 
 
Note: If you hold down the SHIFT key while executing this 
command, only the selected objects will be enlarged to their 
optimal size. 
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2.2.4 The Drawing Tools  

 

Fig. 30: The Drawing Tools 

Note: You will find a detailed of the drawing tools in the 
Reference Section. 

2.2.5 The Measure Tool 

 

Fig. 31: The Measure Tool 

The measuring tool is used to perform measurements (between 
any two points) in your design. As soon as you click on the 
Measure icon in your tool box, the cursor changes into a bull’s 
eye. Move the center of the bull’s eye to the first point, i.e. the 
point from which you intend to measure.  
 
While holding down the left mouse button, drag the bull’s eye to 
the second point, i.e. the end-point of the distance you are 
measuring. A guideline provides a visual connection between the 
two points. 
 
Note: If you hold down the SHIFT key during this procedure, the 
measuring can be limited in a horizontal or vertical direction. This 
makes it easier to measure straight lines accurately. 
 

1. Rectangle  

2. Ellipse 

3. Line / Curve 

4. Digitze mode 

5. Freehand drawing 

6. Symmetrical object 



 
 
 

 

HOW TO WORK WITH EUROVECTOR Chapter 2 

27 

 

Fig. 32: The Measure Dialog Box 

The Length box indicates the result of your measurement. To 
change this value, click on the text box and enter the new length.  
 
You can also make changes to the Percentage box below.  
 
The dialog box provides additional information such as the Angle 
of the line you measured, the Width of the object you measured 
and the Difference in Height between the first (beginning) and 
second (end) point. 

2.2.6 The Fill Tool 

This tool can be used to fill objects with fountains fills or bitmaps. 
Four icons are available here. 
 

 

Fig. 33: The Fill Icons 

 - creates fountain fills 
 

 - adds bitmap fills 
 

 - deletes all fills 
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 - assigns layer color as fill when the object has a fountain or 
bitmap fill 

Delete Fills or Bitmap Fills 

 

Fig. 34: The Delete Icon 

If you click on this icon fills and bitmap fills will be deleted from 
all selected objects. Only the wireframes of the objects remain in 
the previously assigned color. 
 
Example: 
 
Original 

 
black layer 
 
Lettering with Fountain Fill 
 

 
Lettering after clicking on the Delete button 
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Creating Fountain Fills 

 

Fig. 35: The Fountain Fill Icon 

If you click on this icon, the Fountain Fill dialog box opens, 
where the you can specify the appearance of the fountain fills of 
closed curves, text strings or combinations.  
 

 

Fig. 36: The Fountain Fill Dialog Box 

Customizing Fountain Fills 

In the Type box you can select the type of fountain fill. You have a 
choice of Linear, Radial, Conical and Rectangular. The 
appearance of each type is shown in the preview  in the top right 
of the dialog box. 
 
In the Steps Screen box you can specify the number of fountain 
fill stripes to be displayed on the screen. 
 
With Steps Printout you can specify the appropriate number of 
steps for printing out. 



 
 
 

 

HOW TO WORK WITH EUROVECTOR Chapter 2 

30 

The Horizontal Center and Vertical Center allow you to fix the 
center point of the fountain fill. 
 
Note: These boxes are not active for the Linear type of fill. 
 
If you enter 0%, the center of the fill exactly coincides with that of 
the filled object. The center can be moved to the right or left by 
100% of the object width or upwards or downwards by 100% of 
the object height. 
 
The origin can also be set with the mouse. To do this, move the 
mouse cursor to the preview window and click with the left 
mouse button on the point you wish to set as origin. 
 
The Angle box describes the position of the fountain fill stripes 
with linear, conical and square fills. When Linear is selected, 
you can also fix the angle of the fountain fill with the help of the 
preview window.  
 
To do this, click on any point in the window. Keep the mouse 
button held down and move the mouse. A line with its starting 
point anchored down appears and follows the movements of the 
mouse. After you release the mouse button, the angles set by the 
line will be saved. 
 
Note: The size of the margin can only be changed with linear 
and square fills. The entered value - between 0% and 45% - 
specifies the position of the first and last colors in relation to the 
center of the fill.. 

Setting the Beginning Color 

The Fountain box allows you to determine the initial and final 
colors and also the positions and colors of any intermediate 
steps. The bar between the two triangles, the fountain fill bar, 
displays the fountain fill. 
To determine the initial color, click on the left-hand triangle.  
To change the color, there are two possibilities available.  
If you double-click on the Color box on the left of the color 
palette, the Color Selection dialog box appears. 
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Fig. 37: The Color Selection Dialog Box 

The starting color can be modified using this window. 
 
In the color palette on the left side of the window there are 256 
predefined colors available to you. You can select a color by 
simply clicking on the desired color with the left mouse button. 
Further colors can be made visible by using the scroll bar to the 
right of the color palette. You can select one of the colors for the 
fill by simple clicking on the appropriate field. 
 
To modify a color, double-click on the field in question. Then the 
Color Selection dialog box described above appears so that 
you can perform the change.. 
 
You can select a new color from the color palette on the right of 
the Color Selection dialog box. If the color you want is not 
visible, use the scroll bar to make it appear. You can specify the 
color as starting color by simply clicking on the field in question. 
 
If you double-click on the desired color box, this will reopen the 
Color Selection dialog box so that you can choose the color. 
The selected color is displayed in the Color box next to the 
palette. 
 
Selecting the Target Color and Further Color 
Gradations  
 
To specify the target or final color in the fill, first click on the 
triangle on the right side of the color gradation bar. 
Now you can select a new color in the manner described above. 
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Further color gradations can be added by double-clicking on the 
bar above the gradation bar. 
A small triangle showing the position of the color in the fill is 
displayed at the selected position. The exact position is entered 
as a percentage in the Position box. 
 
The position can be modified by moving the triangle or entering 
the desired percentage in the Position box. To position the color 
as you wish, first select the triangle which points to the position in 
question. Then you can specify a new color in the ways described 
above. 
If you wish to delete one color gradation in the fill, click on the 
triangle representing it. Then press the DEL key. 
The triangle will disappear from the bar and the color is no longer 
included in the fill. 
 
Note: It is not possible to delete the starting and target colors in 
a fill. 

Creating Bitmap Fills 

 

Fig. 38: The Bitmap Fill Icon 

This command is used to open the Bitmap Fill dialog box, which 
allows you to fill your objects with bitmaps. 
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Fig. 39: The Bitmap Fill Dialog Box 

Selecting a Bitmap Fill 

First you must determine the bitmap to be used to fill the selected 
object. Three possibilities are available to you: 
 
1. Scan in a New Bitmap Fill 
Scan in the image to be used as a bitmap fill using the 
EuroVECTOR Twain interface (Tools menu / Scan).  
 
Open the Bitmap Fill dialog box. 
 
The selected bitmap will be displayed in the preview window and 
also appears in the box headed  
 
Available Bitmaps. 
Make your settings and click on OK to confirm. 
If the result is not to your satisfaction, you have the possibility to 
“detach“ the bitmap and restore the scanned in image to its 
original state.  
 
To restore the original image, choose the menu item Detach 
Bitmap in the Edit menu. 
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2. Import New Bitmap Fill 
To select a new bitmap as fill, click on Import Bitmap Fill. A 
File Selection dialog box will appear, which allows you to look 
for and select the desired bitmap. 
The selected bitmap will then be displayed in the preview window 
and also appears in the bar with the available bitmaps in the 
lower left of the dialog. 
 
3. Add Used Bitmap Fill 
If you wish to make use of a bitmap fill which has already been 
used, select the desired bitmap from the list of available bitmaps 
by simply clicking on it with the mouse.  
To make bitmaps not displayed appear, you can use the scroll bar 
in the lower right part of the screen. 
 
Choose the type of bitmap fill you want in the Fill Mode box. The 
possibilities are Tiling, Seamless Tiling, Adapt and Object 
Size. 

Tiling 

The Tiling command fills the object with tiles drawn next to each 
other horizontally and vertically from the selected bitmap fill. 
The width and height of a single tile can be specified in the 
appropriate boxes in the measurements group.  
Tick the Proportional box to ensure that, when either the height 
or width is modified, the other value is also adjusted 
proportionally to avoid the bitmap being distorted.  
 
If you activate Scale with Object, the dimensions of the tiles will 
be automatically adjusted in the case of a distortion. 
Tiling normally starts in the upper left corner of the object. With 
the aid of the X Position and Y Position boxes you have the 
possibility of changing the starting point. 
 
Enter a negative value between 0% and 100% to move the tile to 
the left or right. 
If you enter a positive value between 0% and 100% the center of 
the first tile will be moved either to the right or downwards.  
 
If you select Move, you can move the tiles within the rows. To X 
or To Y allows you to specify if you wish to move the tiles in a 
horizontal or vertical direction.  
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You can enter the size of the move in the box on the right as a 
percentage of either the tile width or height.  

Seamless Tiling 

Seamless Tiling  is basically the same as Tiling. The only 
difference is the way the tiles are represented.  
With seamless tiling the squares are all drawn with exactly the 
same dimensions. This produces a more even picture especially 
with patterns. 
The drawback of this method is that the position of the tiles can 
vary when the view is magnified.  

Adapt 

If you use the Adapt command the bitmap is only drawn once in 
the object. The preview window displays the exacts proportions of 
the bitmap and the object. 
 
In the Width and Height boxes you can specify how large the 
bitmap fill is to be. 
The bitmap position within the objects can be modified in two 
ways. 
 
1. In the X Center and Y Center boxes you can determine how 

far the center of the bitmap is from the center of the object as 
a percentage. 

2. You can also specify this position using the preview window. 
Click on the bitmap in the preview window and hold down the 
mouse button. 

 You can then position the image by moving the mouse. When 
you release the mouse button, the image will remain in the 
selected position. 

Object Size 

This command adapts the bitmap exactly to the contours of the 
object. The width and height of the object are calculated so that 
the entire area of the object is filled. 
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2.2.7 The Pencil Attributes Tool 

 

Fig. 40: The Pencil Attributes Toolbox 

These tools provide objects with pencil attributes, create hairlines 
or delete pencil attributes.  

Deleting Pencil Attributes 

 

Fig. 41: The Delete Icon 

Clicking on this icon deletes all pencil attributes. 

Creating Hairlines 

 

Fig. 42: The Hairline Icon 

Clicking on this icon creates a hairline around selected objects. 
This hairline can be used for cutting the objects.  
 
Note: The thickness of this hairline is not variable and is always 
0.1 mm (.0039 in). 

The Pencil Attributes Dialog Box 

 

Fig. 43: The Pencil Attributes Icon  

The Pencil Attributes dialog box can be used to create outlines 
of curves, combinations of objects or text strings. 
Outline pencils can be used to draw object contours in the Full 
Surface or Preview mode. 
 
Note: The Pencil Attributes tool does not affect the 
representation of objects in the wireframe mode (F9). In this 
mode the contours of objects are drawn with a simple outline in 
the layer color. 
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Fig. 44: The Pencil Attributes Dialog Box 

If you select No Wireframe, the contour of your object will not 
be emphasized. 
 
If you choose the Full Surface or Preview mode, closed curves 
will be shown as surfaces without contour lines. Open curves will 
be shown as contours in the appropriate layer color, as in the 
Wireframe mode.  
 
If you select Hairline, a thin line of uniform thickness will be 
drawn around your object. You can specify the color of the 
hairline in the Color box.  
 
The color may be different from the layer color. It is thus possible 
to make a contrast between your objects and their fillings in the 
full surface mode as well. 
 
Select Line Thickness  in order to define the thickness of the 
hairline. 
 
 
 



 
 
 

 

HOW TO WORK WITH EUROVECTOR Chapter 2 

38 

Here there are further settings available: Scale With Object will 
adjust the line thickness proportionally when your object is scaled 
or distorted. If you do not select this option, the thickness of the 
hairline remains unchanged.  
 
You can select the Wireframe Behind Fill option to prevent the 
outline running into the fill. The contour will then be drawn prior 
to the fill so that only the part of the contour outside the fill is 
visible.  
Furthermore, you have the possibility of defining the shape of the 
corners. 
You can choose between cut-off, rounded and sharp corners. 
Icons show the shapes of the various corners, which are also 
displayed in the preview window. 
Besides this, you can also determine the shape of the ends of 
open contours. They can be cut off, rounded or extended. For 
this, please see the appropriate displays. 
The current pencil color is shown in the color box left of the 
palette and also in the preview window.  
There are two ways of changing the pencil color:  
 
1. To determine a new color for the pencil, double-click on the 
color box left of the palette. The following Color Selection 
dialog box will appear with the current of the pencil color settings: 
 

 

Fig. 45: The Color Selection Dialog Box  

Once you have specified the pencil color, it will appear in the 
Pencil Attributes dialog box in the color field next to the color 
palette. The pencil color will also be shown in the preview 
window.  
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2. The palette offers you a choice of 256 predefined colors. You 
can select one of them by simple clicking with the mouse on the 
appropriate color box. You can use the scroll bar to the right of 
the color palette to make other colors visible. You can define a 
particular color as the pencil color by simply clicking on it with the 
mouse.  
If you wish to modify the color, double-click on the appropriate 
color field. The Color Selection dialog box described above will 
appear so that you can make the modifications you desire. 

2.2.8 The EuroVECTOR Color Layerbox  

The color layerbox can be used to color objects, define different 
vinyl colors, select objects of specific colors and lock certain 
color lavers or make them invisible. 
 

 

Fig. 46: The EuroVECTOR Color Layerbox 

Layers 1 through 6 are predefined and cannot be changed. To 
make the color layerbox reappear either press CTRL+2 or select 
Show Layerbox in the Settings menu. 
 
The layerbox can be moved at any time by clicking with the left 
mouse button on the gray bar above Pal > or on the small gray 
area underneath the last layer. The gray frame around the color 
layerbox becomes black and you can move the color layerbox to 
any position you wish on the EuroVECTOR desktop with the left 
mouse button held down. 
 
If you click on the PAL button, a popup menu with the following 
items opens: 
 
Layer Numbers 
If you execute this command, all the layer numbers will be made 
invisible. 
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New 

All color layers with a layer number higher than 6 will be 
deleted.You can use this command when you want to specify a 
new color palette individually. 
You can choose layer colors by clicking once with the mouse 
cursor on the desired color and then on the OK button. 

Load... 

This command loads previously defined palettes. 

Save 

This command permits you to save a newly defined or modified 
default palette on your hard disk. 
 
If this new or modified palette is saved as the default palette, this 
palette will be used ever time you start EuroVECTOR. 

Save As... 

This command permits you to give the palette a name. 

Default 

This command loads the palette supplied as the default for 
EuroVECTOR. It is a Mactac table of vinyl colors, which is 
defined as the default palette with the help of the range of colors. 

Palette History 

This tool makes it possible to load  the last 4 color palettes 
without having to use the directory structure. The names of the 
last 4 color palettes worked with appear at the end of the color 
palette menu list. You can open the desired palette by clicking on 
it with the mouse cursor. 
 
By clicking on the Sel icon you can simultaneously select all 
objects that were created in the selected color layer. 
 
By clicking on the New icon and making appropriate selections 
in the Layer Setup dialog box, you can define new color layers. 
 
Double-clicking on one of the layers/colors will assign the color 
to all previously selected objects.  
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A single click with the right mouse button on one of the color 
layers will open the Layer Setup dialog box. 
 
You can also open this dialog box by using the shortcut L. 
Double-clicking with the left mouse button with the CTRL key 
held down provides the selected object with a wireframe in the 
color currently activated. When the Layer Setup dialog box is 
open, you can use the PAGE UP button to choose and install the 
next color upwards and the PAGE DOWN button for the next 
color downwards. 
When the last color layer in the layerbox is active, a new layer can 
be added. 

The Layer Settings Dialog Box 

 

Fig. 47: The Layer Settings Dialog Box 

In the Layer Settings dialog box there is a choice of 3 color 
models: 
 
1. Cyan, Magenta, Yellow, Black 
2. Red, Green, Blue 
3. Color, Saturation, Brightness 
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Layer Attributes 

Locked means that a particular color layer is no longer available 

for selection. A lock  in front of the layer color 
symbolizes this status. 
 
Invisible makes selected objects disappear from the desktop. A 
crossed-out eye  in front of the color layer that has been 
defined as invisible symbolizes this status.  
 
Note: All attributes can be reversed at any time simply by using 
the right mouse button to click on the appropriate color layer,  
which activates the Layer Setup box in which you can make all 
necessary changes 

Layer Designationg 

In the Material field you can, for instance, assign a specific type 
or manufacturer of vinyl to the color layer. 
 
Under Color Number you may also enter the corresponding 
product number. 
 
Note: The advantage of using these fields is that you can assign 
a color layer to all the materials you carry in stock. The selections 
made during the design process will then be evident when the 
job goes to production. Palettes, i.e. specific sets of color layers, 
can be created and stored for each type of vinyl or other material. 

Shortcuts in Layer Editing 

The following shortcuts are available for layer editing: 
 
L opens the Layer Setup dialog box 
 
Speed when scrolling in the color layer box: 
 

-SHIFT 10 times 

-CTRL     100 times 

-SHIFT +CTRL 1000 times 
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Skipping in the Layerbox: 
 
POS1 Skip to the first layer 
ENDE Skip to the last layer 
PAGE up/down  Skip over 1/10 of the number of 

layers 
Cursor up/down Skip to next layer 
 
Advantage of the Page up/down keys: 
While the new layer is being chosen the Layer Settings dialog 
box remains open and the appropriate numbers can be entered 
directly. 
 
CTRL+Double-click Assigns a selected object an outline in 

the currently active color. 
 
Move Single Color Layers 
 
1. Position mouse cursor on desired layer  
2. Press left mouse button and keep itheld down  
3. Move the layer to the desired position 
4. Press right mouse button once 
5. The color layer is in the new position 
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2.2.9 The Print Command 

 

Fig. 48: The Print Icon 

The various functions of the EuroVECTOR Print dialog box are 
explained in detail in the following section. 
 
Open the EuroVECTOR Print dialog box by selecting Print in 
the File menu, using the shortcut CTRL+P on the keyboard or 

clicking on the  icon in the toolbox. 
 
The following window opens: 
 

 

Fig. 49: The EuroVECTOR Print Dialog Box 

In the lower right part of the dialog box you will find the Tiling 
option and the Adapt button. 
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The appearance of the Print dialog box changes depending on 
which button you have activated.  
 
When the Print dialog box is called up, the Adapt button is 
automatically activated, because objects or graphics cannot be 
printed in formats exceeding the maximum output size of the 
printer being used. 

The Adapt Command 

The Adapt command lets you specify the printable area. The 
values for the printable area are shown in the Printing Area box 
located in the upper right part of the Print dialog box.  

The Preview Window in the Adapt Mode 

This window allows you to recheck your job before it is printed. 
The edges of the window are magnetic, that means that when an 
object nears the edge of the page it sticks to the edge of the 
window. The Snap to Edge command allows you to position 
your objects quickly in the corners or at the edges of pages. 
 
Tip: If you want to turn off the Snap to Edge command, hold 
down the SHIFT key while positioning your objects.  
 
The coordinates appearing below the preview window show the 
position of the upper left corner of the first object in the working 
area.  

Mouse Functions in the Preview Window (Adapt 
Mode) 

Clicking once with the right mouse button enlarges the preview 
window to its maximal size.  
 
The size of the display depends on the selected screen 
resolution. (800*600, 1024*768,...). 
If you click again with the right mouse button the original state is 
restored. 
 
If you hold down the left mouse button, a dotted black frame 
appears around the objects to be printed. 
This frame always encompasses all objects located on the 
working area and corresponds to the printing area. 
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Printing Area and Object 

The items Printing Area and Object are located in the upper 
right area of the Print dialog box. 
 

 

Fig. 50: Printing Area and Object 

Printing Area 
This box shows the height and width of the specified printing 
area. 
 
Object  
This box displays the object(s) to be printed with its/their heights 
and widths. 
 
Note: The boxes for the percentual enlargement of objects are 
not active in the Adapt mode. 
 
Beneath the Object field, on the right side of the Print dialog 
box, you will see the Printer field. 

Printer 

 

Fig. 51: Choice of Printerl 

If you open the combobox in the upper part of the dialog box, you 
will obtain a list of all the printers installed on your system. Select 
the printer you wish to use. 
To make further settings for the printout, click on the Setup 
button.  
The dialog box which appears is the same as the menu item 
Properties in the Printer File menu. 
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Note: The Print dialog box opened by clicking the Setup button 
depends on the printer driver loaded and for this reason is not 
explained in greater detail here. 
You can specify the Page Format (upright/oblong) in the field to 
the right of the Setup button. 

What is to be printed ? 

In the field headed Print Mode there are two comboboxes which 
you can use to determine what is to be printed. 
In the first box you can choose between Objects and Objects 
with Worksheet. 

Objects 

All objects in the working area will be printed. 

Objects with Worksheet 

All objects and also the worksheet (black frame) will be printed.  
The company name, the dimensions of the working area and the 
proportional size of the printout will also be printed automatically 
below the black frame.  

Job Info 

If you perform this command, the information entered in the Job 
Info will be printed and also a reduced version of all objects in the 
lower right part of the sheet. 
 
The following settings are available in the second box: All 
Objects, Selected Objects, Print Color Separations (print in 
layer sequence), Print Single Layers (colors). 

All Objects 

All objects in the working area will be printed. 

Selected Objects 

Only selected objects on the working area will be printed.  

Printing Color-Separations  

All objects of one color will be printed in the sequence shown.  
The color bar (layer order) in the second box contains all the 
colors (layers) which have been used in the working area. 
The colors will later be printed in this sequence. The darkest 
color is always printed first. 
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Print Single Colors (Layers) 

The colors listed in the second box are those which have been 
used for the objects in the working area. If, for example, there is 
only a black and a red object in the working area, there will be a 
choice of only two color bars (layers) available.  

Proportion 

You can enter the proportion in which the printout should be 
made in one of two boxes, either as a figure or a percentage. The 
boxes are linked, i.e. if you enter a figure, the equivalent 
percentage will automatically appear in the box and vice versa. 
 
Examples of proportional entries in figures with the 
corresponding percentages: 
 
Proportion     1 : 1      100.00 % 
Proportion      1 : 2        50.00 % 
Proportion      1 : 3        33.33 % 
Proportion      1 : 4        25.00 % 

Center 

If this option is activated, all objects on the working area will be 
centered.  

Tiling 

If this option is selected, the Print dialog box appears in the 
Tiling mode.  

Number of Copies 

In this box you can specify the number (max. 9999) of copies to 
be printed. 
The Adjust and Tiling buttons permit you to switch to and fro 
between these two modes. 

1:1 

When this button is activated, all objects in your working area will 
be displayed in their original size. 

Adjust 

When this button is activated, the objects in the working area are 
reduced so that they can be shown in their entirety in the preview 
window.  
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Print Colored Worksheet 

If you choose this option, your worksheet will be printed with the 
specified background color. 

Print Guidelines 

If the job contains guidelines, these will also be printed. 

Always Print Black 

This option will automatically be activated when All Objects is 
selected in the first box and Print Color Separations (in layer 
sequence) or Print Single Colors (single layers) is selected in 
the second box. 
If you want to print the objects in the working area in color,  the 
command must be deactivated. 

Register/Crop Marks 

This option will automatically be activated when All Objects is 
selected in the first box and Print Color Separations (in layer 
sequence) or Print Single Colors (single layers) is selected in 
the second box 
If you do not want the register/crop marks to be printed, the 
Register/Crop Marks button must be deactivated beforehand.  
The following table shows all possible combinations for 
comboboxes 1 and 2 and the possible choice of settings in the 
Adapt mode. 

Fig. 52: Possible Settings in the Adapt Mode 
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Buttons in the Print Dialog Box 

The OK Button 

If you click on this button, the settings made will be transmitted to 
the printer. 

The Cancel Button 

You can use this button to exit the Print dialog box. 

The Tiling Mode 

If you switch from the Adjust mode to the Tiling mode, the 
following preview window appears: 
 

 

Fig. 53: The Preview Window in the Tiling Mode 

In the Tiling mode all tiles are displayed.  
 
A tile is the part of an object which can be printed or cut on the 
plotter being addressed. 
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Break After indicates after which tile (enter the number of the 
tile) the plot should be stopped. You can enter the desired 
horizontal/vertical intersection of the objects to be printed in the 
boxes under Overlap. 
 
If you print using Roll, complete stretches can be printed without 
any spaces between the single tiles. 
You can only stop the printing of a complete stretch and not of 
the individual tiles. 
 
Entering an intersection in the printing direction does not have 
any effect on this operation, as can also be seen from the display 
of the tile size. 
 
Note: After tiling, the dialog box will not automatically be closed, 
as it is useful to be able to compare the preview directly with plot. 
This also allows you reprint a particular tile immediately. 

Mouse Commands in the Preview Window (Tiling 
Mode) 

You can enlarge the tiling view to the size of the screen by 
clicking once with the right mouse button on the tile preview 
window. A second click with the right mouse button will restore 
the original state.  
Double-clicking with the left mouse button on a tile deactivates 
the tile, i.e. it is not printed.  
If you double-click with the left mouse button while holding down 
the CTRL key, the tiling will be inverted, i.e. the tiles which were 
previously deactivated will be activated (printed) and the tiles 
which were activated will be deactivated (not printed). 
 
The objects can be moved within the preview window using the 
mouse. The Snap to Edge function activates you to position 
your objects easily at the edge of the window. You can turn off 
the Snap to Edge function by pressing the SHIFT key.  

Example of Printing in the Tiling Mode  

In the following example, the various functions, shortcuts, etc. in 
the Tiling mode are explained again in detail. 
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The Tiling mode offers you the possibility of printing in any size, 
i.e. any artwork, regardless of its size, can be printed out on the 
printer connected to your system. 
To print your artwork, you do not require a printer for printing A2, 
A1, A0 or even large formats.  
 
How is this done? 
The artwork to be printed is divided into as many sections (tiles) 
as necessary to be able to print it on the printer connected to 
your system.  
The number of tiles necessary depends on the size of the artwork 
to be printed and the output format (A3, A2, etc.) which has been 
specified.  
You can determine the output format using the Setup button in 
the EuroVECTOR Print dialog box. The format depends on the 
printer which is connected to your system.  
 
Load any artwork you like to EuroVECTOR and open the Print 
dialog box, either by clicking Print in the File menu, by pressing 
CTRL+P on the keyboard or by using the button in the toolbox. 
 
The EuroVECTOR Print dialog box will be opened in the Adapt 
mode. Activate the Tiling mode by clicking the appropriate 
button.  
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The Print dialog box appears as follows: 
 

 

Fig. 54: The Print Dialog Box in the Tiling Mode 

In the upper right corner of the dialog box you will see two fields, 
Tiling and Object. The Tiling field corresponds to the Printing 
Area box in the Adapt mode. The other fields in the right half of 
the Print dialog box behave in the same manner as in the Adapt 
mode.  
 
In Fig. 55 you can see the preview window in the Tiling mode. 
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Fig. 55: The Preview Window in the Tiling Mode 

The preview window in the Tiling mode shows all the tiles which 
are required to print out the entire artwork. 
Eight pages, for instance, are required to print out the artwork in 
the example. 
A change in output format always necessitates an adjustment in 
the number of tiles.  
Beneath the preview window you will find the fields Break After, 
Tiling and Roll. 
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Vertical and Horizontal Overlap 

The number of tiles increases depending on the number of 
vertical or horizontal overlaps which you have specified. 
The following example illustrates this: 
 

 

Fig. 56: Two Tiles Without Overlap 
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Fig. 57: 3 Tiles With Overlap 

Fig. 57 shows that the number of tiles increases when you use an 
overlap. 

Activated and Deactivated Tiles  

An active tile means a tile which is not marked with an X, 
whereas deactivated tiles are always marked with an X.  
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Fig. 58: Deactivated Tile  

Tiles can be deactivated or activated by double-clicking on them 
with the left mouse button, i.e. a tile is deactivated with a double 
click. A further double click will reactivate it. 
 
You can see from Fig. 58 that tile number 2 is marked with an X. 
This tile has been deactivated and will not be printed. 
In the Tiling mode you have a further possibility besides 
activating or deactivating single tiles.  
 
If you hold down the CTRL key while double-clicking on the 
desired tile with the left mouse button, all tiles, except the one 
On which the mouse cursor is positioned, will be deactivated. 
 
Fig. 59 and Fig. 60 illustrate this. 
 

 

Fig. 59: Six Tiles Active (Mouse Cursor is on Tile 4) 
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Fig. 60: Tiles 1, 2, 3, 5, & 6 Deactivated, Tile 4 Activated  

Advantage of deactivating tiles: 
 
When your objects are arranged, tiles without objects (empty 
tiles) may be created, which would result in a blank page being 
printed.  
 
Other Important Functions 
Important commands which need to be accessed quickly can be 
added as icons in the area near the Object Attributes toolbar. 
 

 

Fig. 61: Area for Adding Important Function Icons 

If you position the mouse cursor in this area and click once with 
the right mouse button the following dialog box opens: 
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Fig. 62: Dialog Box for Adding Other Function Icons  

The Available Operations are located on the left. The Selected 
Operations are shown on the right. If you are in the left part of 
the dialog box and an operation is active (blue background), you 
can add this operation. If you are in the right part of the dialog 
box and an operation is active (blue background) you can delete 
it. 

2.2.10 The Align Tool 

 

Fig. 63: The Align Icon 

This command aligns two or more selected objects to each other 
or to the working area. 
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Fig. 64: The Align Dialog Box 

Objects can be aligned either horizontally or vertically. It is also 
possible to center the objects or to align selected objects with an 
equal distance between them. 

2.2.11 The Rotate Axis Command 

 

Fig. 65: The Rotate Axis Icon 

This command is used to rotate objects by 90°.  
You need this option regularly if you want to adjust your objects 
quickly to the running direction of the vinyl without performing the 
rotate command. 
 
Note: The A key also performs this operation  
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2.2.12 The Contour Line... Tool 

 

Fig. 66: The Contour Line Dialog Box 

This command provides a number of selected objects with an 
outline. 
Unlike the Outline command, this tool can also be used to 
provide bitmaps with outlines. Instead of individual objects being 
outlined, if possible an outline is created to encompass all the 
selected objects. Therefore the function is particularly useful for 
creating cutting lines for stickers. The objects for the sticker can 
be put together as you wish. 
The outline is then created at whatever distance you wish from 
the objects. It can later be used for cutting out the printed sticker. 
 
First select the objects you wish to frame. Then click on  Contour 
Line... in the Tools menu. 
 
The following dialog box appears where you can make the 
settings: 
 

 

 K 
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Fig. 67: Extended Settings 

The fields in the Create Contour part of the dialog box allow you 
to influence the calculation of the contour line. In principle, any 
objects which are not white are included in the contour 
calculation. 
Therefore the background of the artwork to be outlined should 
ideally be white. Bitmaps, in particular, often contain light-gray 
patches which may arise during scanning. 
With the aid of the field Maximal Gray Value you can determine 
that gray patches above the specified intensity should not be 
framed. 
 
You can enter values between 50% and 99% or set them with the 
filter. 50% represents a relatively dark gray and 99% is almost 
white. 
You can choose between three options in the Accuracy box. 
Low accuracy works the most quickly. If you are not satisfied with 
the result with the low setting, choose the middle or high setting. 
In the latter cases it will take longer to calculate the contour line. 
 
Note: If you only select one bitmap, the Accuracy box cannot be 
activated. 
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If you check the Retain Inner Parts box, any inner parts which 
may be created will not be deleted. This gives you the possibility 
to cut out parts of the graph by covering it with light-colored 
“plasters”. 
 
This is illustrated below: 
 

 

Fig. 68: Retain Inner Parts 

On the left you can see the two objects in their original state. A 
small white circle is superimposed on the black circle. On the 
right the circle is displayed with the outline which has been 
created. As the Retain Interior Parts field was activated, the 
inner circle was also retained when the outline was created. If 
this field had not been activated, only the exterior outline would 
have been created. 
 
Note: The default is that the Retain Inner Parts command is not 
active. 
 
The lower part of the Contour Line dialog box, Offset and Line 
Drawing allows you to determine the appearance of the contour 
lines. 
 
With Offset you can specify the distance of the contour line from 
the image. If you enter the value “0”, a contour line will be created 
directly adjoining the edge of the selected objects. If you enter a 
value smaller than 0 the contour line intrudes on the objects to be 
outlined. 
 
In the Corner Shape field you can determine the appearance of 
the corners of the contour line. 
 
If you choose the Normal option, the mathematically exact point 
will be calculated on the contour. This means that the contour line 
can be considerably lengthened at pointed corners, which often 
leads to unsightly results. 
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In such cases you can achieve more satisfactory results by 
choosing the Cut Off and Round options. 
 
The Cut Off option shortens the contour by the specified amount 
and cuts off the corner with a straight line. 
 
The Round option changes the corner into a rounded curve. If 
you activate the Enhanced... button, an additional dialog will 
appear in which you can make the exact settings for the design of 
the corner. 
 
Note: The default settings in the Enhanced Settings dialog box 
should only be altered in exceptional cases! 

2.2.13 Scanning and Vectorizing 

 

Fig. 69: The Vectorizing Button 

With these two powerful EuroVECTOR functions, you can 
convert scanned images (bitmaps) into vectorized contours that 
can be cut by your plotter.  
 
The optics of the scanner register individual points or pixels in the 
image. There are two ways of transferring this data to 
EuroVECTOR.  
 
The simplest way is through the TWAIN interface. TWAIN is a 
software product used for image data transfer between different 
programs. It is usually supplied along with your scanner. 
 
If you do not have access to TWAIN, the only other way to import 
the scanned data is through standard EuroVECTOR import 
procedures, e.g. using BMP, PCX or TIF files. 
 
When there is a bitmap in the EuroVECTOR  
working area and it is selected, the Vectorize command is 
activated and the following dialog box appears: 
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Fig. 70: The Vectorize Dialog Box 

To optimize the vectorizing process, four different types of filters 
are available: 
 
Filter 1: 
Filter Contours reduces major noise (garbage) by ignoring 
contours consisting of less than five pixels.   
 
Filter 2: 
Reduce Tangential Points reduces the number of points or 
nodes on a curve. The higher the degree of reduction, i.e. the 
fewer the nodes that are retained, the further the scanned curves 
will deviate from the original. On the other hand, fewer nodes 
means less clean-up. Therefore, a moderate amount of reduction 
generally constitutes a workable compromise. 
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Filter 3: 
Adjust Curves considers the overall direction of straight lines 
and curves and eliminates stray horizontal and vertical lines that 
appear to have no effect on them. Thus, points or nodes within 
the selected tolerances are ignored during the vectorizing 
process. 
 
Filter 4: 
Smooth Curves aligns the tangents of curve points. The higher 
the degree of adjustment, the more the curves are smoothed. 
Smooth curves with perfectly aligned tangents have the 
advantage of producing very clean cuts.  
However, excessive smoothing can once again cause too much 
deviation from the original. Therefore, a moderate value is 
preferable. 
 
With the BMP Outline option in the vectorizing dialog box you 
can choose to have the original bitmap contour reproduced as 
outline, i.e. not filled. The BMP outline will appear as a somewhat 
jagged line in your working area, along with the vectorized 
contour. A gray color layer added at the end of the color layer list 
is automatically assigned to this BMP outline. If you wish to 
assign a different color, select the gray layer (R 128, G 128, B 
128) and activate the Sel icon in the color layer box. Double-click 
on the color layer of your choice to assign it to the BMP outline. 
The BMP outline facilitates clean-up of the vectorized contour 
considerably without affecting its final quality in any way.  
 
If you check the Contours < 5 Pixel option, closed contours will 
be created for objects consisting of fewer than 5 pixels.  
 
With the Background option you can also vectorize objects 
which are of the same color as the background of your image. 
The Without Intersection option allows you to eliminate 
automatically any intersections which may appear within the 
vectorized objects.  
 
The Text strings option makes it possible to achieve better 
vectorizing results. 

Working with Color Bitmaps  

The functions described above apply to the vectorization of both 
black and white and color bitmaps.  
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When scanning bitmaps with a color depth of 24 bits 
(approximately 16 million colors), you must reduce the number of 
colors to 16, prior to vectorization.  
Since each color will have to be assigned a layer and 
corresponding vinyl color, only relatively limited color bitmaps can 
be processed effectively.  
 
It is only possible to convert bitmap colors to vinyl colors when 
the number of colors is reduced. 
 
The following Color Assignment dialog box is used to convert 
bitmap colors to vinyl colors. It is not active the first time you start 
EuroVECTOR. If you wish it to be opened before the Vectorize 
dialog box, you must check the With Color Assignment 
command in the Tools menu.  
 

 

Fig. 71: Color-Assign Bitmap Colors to Vinyl Colors 
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In the preview window titled Original, the scanned 24-bit color 
bitmap is displayed. 
In the preview window titled 16 colors you can see the limited 
color bitmap. Being able to compare both images will help you 
decide which one to use for vectorizing.  
 
Note: Clicking on Cancel selects the original rather than the 
reduced bitmap for vectorizing.  
 
The larger window titled Manually Reduced to: displays the 
image in equivalent vinyl colors.  
 
This gives you a chance to preview the vectorized image the way 
it will look once it is cut out of vinyl.  
The column of colors under the heading Color is used to 
combine similar colors or hues.  
Select a color by clicking on it once; holding down the SHIFT key 
will allow you to select additional colors.  
Deactivate colors by simply clicking on them once again. 
 
The Assignment column shows the vinyl colors representing 
combined original colors and hues. 
 
What is color assignment? 
 
The figure below shows a bitmap with 16 colors/vinyl colors. 
But in practice nobody will want to mount 16 vinyl colors. 
Therefore similar colors are combined, thus reducing the number 
of colors/vinyl colors. 
 
Example: 
 

 
 
In the figure above the shades of blue are to be combined. To do 
this, select the dark blue and light blue boxes in the column 
entitled Color by clicking with the left mouse button. 

 
dark blue 

 
light-blue 
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Note: You can select further colors with the left mouse button. 
You can unselect the selected colors with the right mouse button. 
Selected area are shown with a black frame. 
 
Now select the shade of blue for your vinyl in the column entitled 
Assign To by clicking on the left mouse button. 
 
You will see that the light blue bar in the colum entitled Vinyl has 
changed to dark blue. 
 

 
 
You proceed in exactly the same way with the other shades of 
color which you would like to merge. 
 
The dialog box for making the vectorizing settings now opens. 
Confirm the settings made by clicking on OK. 
 
Note: When the With Color Assignment command is turned 
off, the colors can be reduced later via the color layer box.  
Ist der Menüpunkt Mit Farbzuordnung  

Important Information on Scanning  

1. Optimal scanning results are achieved by using the highest 
possible optical resolution on your scanner.  

 Most flat-bed scanners offer a resolution of 300 to 600 dpi. 
Please consult your scanner manual for exact 
specifications.  

 
2. Use the highest-quality original possible; if necessary, make 

a reduced (smaller) photocopy to give you better edge 
quality and, ultimately, better vectorization.  

 
3. The determining factor in the time required for vectorization 

is the amount of data, which is proportional to the size of 
the bitmap. Therefore, a small original will work much 
better. 

 

 
dark blue 

 
dark blue 
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4. Please make sure you place the original in your scanner at 
a right angle. Even small deviations can distort the image 
and reduce the quality of the scan, thus increasing the 
amount of clean-up or editing work. 

 
Note: You can make small corrections in the rotation angle with 
the rotation feature in EuroVECTOR. The smallest possible unit 
for rotation is 0.1mm (.0039 in). Another option is to use the 
measuring tool. Measure the rotation angle and change its value 
to 0 (zero) in order to reposition the image horizontally. 
 
To cut bitmaps out of vinyl, it is not necessary for you to have 
color scanning capabilities. Black-and-white scans produce 
equally good results and are much easier to work with because 
they contain far fewer data. 

2.1.14 The EuroVECTOR Objects Attributes 
Toolbar 

The Objects Attributes toolbar can be turned on and off via the 
Menu window/Object Attributes or simply pressing G on the 
keyboard. 
 

 

Fig. 72: EuroVECTOR Objects Attributes Toolbar 

In this dialog box you can change the parameters for the size or 
position and the skew or rotation of objects. It also allows you 
to enter the number of copies for duplicating objects in x/y 
direction and the x/y offsets.  
 
Thus, the Object Attributes toolbar combines some of the most 
frequently used functions in one window, which considerably 
facilitates editing. In the X and Y boxes you can enter relative and 
absolute X and Y coordinates. 
 
Absolute and Relative Position 
The absolute position means the actual position of the X and Y 
coordinates of the reference point of an object.  
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Reference Point 
When the object is selected, the reference points are 
represented as black squares. These squares correspond to the 
circles in the Object Attributes toolbar. 
 
Note: The center of the selected object is not marked as a point 
of reference. 
 

 

Fig. 73: Object Center and Reference Point 

 

Fig. 74: Example of Relative Coordinates 

If the Relative Position option is chosen, the circles are shown, 
which means that they are no longer active. You should set the 
required point of reference for repositioning the circles before 
activating them. 

 

Fig. 75: Example of Absolute Coordinates 
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In the example X and Y values of 50mm (1.96 ins) were entered 
for the absolute coordinates. 
 
An offset of 60mm (2.36 ins) was chosen for X and Y as relative 
coordinates to this point, i.e. the point of reference was moved by 
60mm (2.36 ins) horizontally and vertically.  
This gives a new absolute value of 110mm (4.33 ins) for the X 
and Y coordinates. 
In the Object Height and Object Width boxes you can enter the 
height and width of one or all selected objects as figures or 
percentages. 
 
If you perform the All Objects command, the values entered 
affect all objects. 
 
The two boxes are linked together, i.e. if the width is modified, the 
height will also be modified by the value entered. 
 
If the length / width link is deactivated the Height and Width 
boxes can be modified independently of each other. 
 

 

Fig. 76: Length/Width Link Deactivated 

The Skew/Rotate Tool in the Object Attributes 
Toolbar 

 

Fig. 77: The Skew/Rotate Tool 

A click with the left mouse button on the Skew button opens the 
following dialog box: 
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Fig. 78: The Skew Dialog Box 

 

 

Fig. 79: Objects in the Skew/Rotate Mode 

You can rotate your object by moving your mouse cursor to the 
round arrows at the corners of the object and keeping it held 
down.  
When the object has been rotated, its position will be shown by a 
dotted blue line. You can see the exact amount of the rotation in 
the status bar on the bottom left of the screen near the mouse 
coordinates. 
 
A positive value rotates objects clockwise, a negative value 
counterclockwise. 
 
If you click on one the straight double arrows while holding down 
the left mouse button, your object is skewed to the left and right 
and upwards and downwards. The sides you click on will be 
moved, whereas the ones opposite remain the same.  
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If you execute the Relative Angle command, the relative angle 
will be shown when the object is rotated or skewed. 

The Multi-Copy Tool in the Object Attributes Toolbar 

 

Fig. 80: The Multi-Copy Icon 

A click with the left mouse button on the Multi-Copy icon opens 
the following dialog box: 
 

 

Fig. 81: The Duplicate Dialog Box 

Number X 
You can enter the number of duplicates in a horizontal direction 
in this box. The arrows to the right of the box indicate the 
direction (right/left) in which the objects are to duplicated. 

 
Number Y 
You can enter the number of duplicates in a vertical direction in 
this box. The arrows to the right of the box indicate the direction 
(upward/downward) in which the objects are to be duplicated. 

 
X Offset 
You can enter the distance you wish to have between the 
duplicates in a horizontal direction in this box.  
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Y Offset 
You can enter the distance you wish to have between the 
duplicates in a vertical direction in this box.  
 
If you execute the Select Objects command, all your objects will 
be automatically selected after they have been duplicated.  
 
If you execute  the Fill Worksheet command, the specified 
working area will be automatically filled with the previously 
selected objects. 
 
The Create Clone tool can be used to save storage space, i.e. 
when an object is cloned, only the data of the original is saved 
but not the data of the clone. 
If the original object is modified, i.e. provided with pencil 
attributes such as fountain fills, the changes will automatically 
apply to all clones of the original object.   
 
Note: Artwork files cannot be cloned. 
 
Example:  
A customer has given you an order to produce 100 of the same 
sticker, with 5 stickers twice the size of the other 90. 
You load the vector template for the job to select the template 

and click on the   (Multi-Copy) button. 
Execute the Create Clone command In the Duplicate dialog 
box and enter the desired number of clones and the horizontal 
and vertical offsets. 
 
The clones will be created when you click on the OK button. 
Clones are represented with dotted blue lines in EuroVECTOR. 
Now select the five clones which are to be cut twice the size and 
drag them to the desired size. Once you have modified the 
clones, the objects will appear in their original color again. 
 
Note: If you modify the size of a clone, it will become an original 
again. 
 
If you execute the Group Result command, the objects filling the 
worksheet or the clones created will be grouped according to the 
sequence in which they were created. 



 
 
 

 

HOW TO WORK WITH EUROVECTOR Chapter 2 

76 

2.2 Importing 

With this command you can load graphics which are in a format 
other than the EuroVECTOR job format to your working area. 
 

 

Fig. 82: The Import Dialog Box with Preview Window 

In the Search In box you can enter the path to be searched.  The 
first time the dialog box opens the  

 button is not active. It does not become active until the path to 
be searched is changed. When you click of this button, the 
program goes to the next higher path. 
 
Clicking the  button allows you to go to the next lower path. 
 
If you click on the  button, a new directory is created in the 
currently active one. 
 
By clicking on the  button you can specify with what 
information and how files are to be displayed.  
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The following import filters are available to you in EuroVECTOR: 

CMX Import 

You can import CMX files to EuroVECTOR with the Windows 
Explorer or via Windows 95 using drag & drop. 
 
Drag & drop is also possible with EPS and bitmap files. 
 
Note: Before you can import files to EuroVECTOR using drag & 
drop, you have to enter the import paths under Import in the 
Basic Settings menu and also select the required filter in 
Preferred Import Filter. 
 
Procedure: 
For drag & drop arrange the program windows (e.g. CorelDRAW 
and EuroVECTOR) on your screen so that they are either 
adjacent to or below one another.  
If you click on the task bar with the right mouse button a menu is 
opened showing you various arrangements of windows.  
Select the object(s) you wish to import to EuroVECTOR and drag 
it (them) to the EuroVECTOR desktop.  
 
It is also possible to import CMX files using the EuroVECTOR 
Import Dialog box.  
 
Objects can also be imported from CorelDRAW 6, 7, 8, 9, 10 & 
11 to EuroVECTOR via the clipboard. 
You can select single objects from CorelDRAW and import them 
to EuroVECTOR using drag & drop.  
 
Note: If you wish to import objects containing text strings, make 
sure that you convert the text strings to curves before importing 
them. The objects will not be imported if you fail to do this. 
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2.3 Exporting 

This command allows you to use jobs created in EuroVECTOR in 
other programs. In order to do this, you must first save them in a 
format other the EuroVECTOR job format. The jobs will be 
exported with the highest quality and the lowest compression 
possible. 
 

 

Fig. 83: The EuroVECTOR Export Dialog Box 

Under Save you can specify the path to be searched.  
In the Search In box you can enter the path to be searched.  The 
first time the dialog box opens the  button is not active. It does 
not become active until the path to be searched is changed. 
When you click of this button, the program goes to the next 
higher path. 
 
Clicking the  button allows you to go to the next lower path. 
 
If you click on the  button, a new directory is created in the 
currently active one. 
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By clicking on the  button you can specify with what 
information and how files are to be displayed.  
The following import filters are available to you in EuroVECTOR: 
 

 
 
HPGL export format exports the file in the standard HPGL format. 
 
If you select one of the four bitmap export filters, the Export 
dialog box will be enhanced with the Color Depth and Color 
Resolution fields. The original default settings for these fields 
are: 8 bits per pixel and 150 dpi (dots per inch). 
 
Color Depth 
The choice of possibilities in these field depends on the export 
filter you are using.  
The following table shows you the color depths available for each 
filter: 
    bits per pixel 
 1 8 16 24 all 
TIFF bitmap — — — — X 
JPEG bitmap — X X — — 
Windows bitmap X X  X — 
Paintbrush — — — — X 

Fig. 84: Settings for Bitmap Export 

Note: When you import a picture, you can see the size of the 
uncompressed bitmap in the Bitmap menu, Bitmap Attributes.  
If the storage space required for the uncompressed bitmap is 
higher than the free space on your hard drive, a message to that 
effect will automatically appear. 
The type of bitmap (e.g. grayscale bitmap) and its color resolution 
are displayed in the status line.  
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EPS Export with OPI Links 

This export variant has the advantage that your image file is 
stored separately and not together with the EPS file in one file.  
If you use an image several times, it will be physically created only 
once, which means a saving of storage space.  
 
Note: If you select certain objects, only they will be exported, 
otherwise all. 

2.4 Loading Jobs 

To open files select Open in the File menu.  
 
The following dialog box appears: 
 

 

Fig. 85: The Open Job... Dialog Box  
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Under Search In you can specify the path to be searched. 
 
The first time you open this dialog box the  button is not active. 
It does not becomes active until the path to be searched is 
changed. You can go to the next higher path by clicking this 
button. 
By clicking the  button you can go the next lower path. 
 
If you click on the  button a new directory will be created in the 
currently active one. 
By clicking on the  button you can specify with what 
information and how files are to be displayed.  
 
The file/job you are working on is displayed in the File Name 
box. The list above shows all files in the EuroVECTOR job format 
which are stored in the selected directory.  
 
The information entered in the Job Info about jobs is displayed in 
the lower part of the dialog box. 
The amount of this information depends on the information 
entered in the Job Info. 
 
The job can be displayed in the Wireframe or Full Surface 
modes. If the job contains images (JPG, PCX, ...), the preview can 
of course not be switched to the Wireframe mode. 
 
The job size, format and date of the last change are shown to the 
right of the preview window. 
 
A selected file can be deleted directly with the DEL key after you 
have been asked if you really wish to do this. 
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2.5 Save Jobs 

This command is used to save the job you have been working on. 
If you have previously saved the job, the file name and directory 
under which it was saved will be maintained. The previous version 
is overwritten and will no longer be available.  
 
If you have created a new job that has not yet been saved, the 
Job Info dialog box will automatically open and then the Save 
Job As.. dialog box.  
 
Note: You should also select the Save As... command when you 
want to save the current job in your network. You should enter the 
appropriate network drive under drives. 
 
The Save Job... command opens the following dialog box: 
 

 

Fig. 86: The Save Job... Dialog Box 

Under Save you can select the directory where the job is to be 
saved. 
 
The first time this dialog box opens the  button is not yet 
active. It only becomes active when the path to be searched is 
changed. You can go to the next higher path by clicking this 
button. 
By clicking   button you can go the next lower path. 
When you click on the  button, a new directory will be created 
in the one currently active. 
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By clicking on the   button you can specify with what 
information and how files are to be displayed.  
 
The name of the job is indicated under File Name. All the files in 
the EuroVECTOR job format that are stored in the selected 
directory appear in the list above. 
 
The File Type is preset to EuroVECTOR job in this dialog box.  
Jobs can be saved in EuroVECTOR 4, 5 or 6 format.  
Jobs can be saved as copy masters with the file format Template 
(ending with JTP). 
 
The file format Reference Job (ending with JRF) saves the job 
file with the driver used to cut it. 
 
A selected file can be deleted directly with the DEL key after you 
have been asked if you really wish to do this. 
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2.6 The Job Info 

You can open the Job Info in three different ways: 
 
1. Via the Editing menu / Job Info. 
2. Automatically when you save a new job. 
1. Via Job Info in the right mouse button menu. 
 

 

Fig. 87: The Job Info Dialog Box 

The Job Info dialog box gives you the possibility of entering 
relevant information on each file. You can print out this 
information and use it for invoicing or as a note accompanying 
the job. 
 
When the job info is printed, the complete path in which it is filed 
will be printed as well. 
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In addition to customer-related information such as Order No., 
Company Address, etc. you can also enter data regarding the 
type of Material used, Duration of production, Number of jobs 
cut or printed and the Price.  
 
In the Memo section you can record any other useful comments. 
 
Using the Settings menu/Job Info you can enlarge the Job Info 
by adding any number of boxes. 
 
Note: Information regarding Materials used will only be 
recorded automatically if during the design process you were 
using color layers/palettes that had been defined in the Layer 
Setup dialog box. 
You can find further information about this in the section 
Layer Setup Dialog Box, page 82 ff.. 
 
Tip: The TAB key is the quickest way to switch between the 
various boxes. 

2.7 RCS ONLINE 

Access to RCS ONLINE  

Via Internet: 

For this you  need acess to the internet, e.g. via T-Online or an 
internet provider. 
 
Advantages of access via the internet:  
 
You only have to pay the charges to your internet provider (usually 
local charges). If you already have access to the internet, no 
configuration is necessary to connect to us. 
 
Open your www browser and type our address:  
 

http://www.eurosystems.lu 
 
http://www.cocut.com 
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3. Reference Section 
Menu items in chronological order: 

3.1 The File Menu  

The New… Command  

This command opens a new job file. 

The Last Version Command 

When a job is loaded a backup copy named AUTOSAVE.BAK 
will be created in the EuroVECTOR directory. This command 
allows you to retrieve  the version of the job that existed before 
loading. 

The Open… Command  

This command loads files stored on your hard disk or a diskette in 
the EuroVECTOR job format to your current screen/desktop.You 
can now edit these files as you wish. You can also delete jobs 
after you have been asked if you really wish to do this.  

The Save Command 

This command saves your current job. If you have already saved 
this job, the given file name and directory will be maintained. The 
old version of the job will be overwritten. 
 
If you have created a new job that hasn’t been saved, the program 
automatically goes to Save As... when you click on Save in the 
File Menu. 
 
First the Job Info dialog box opens where you can enter further 
information about the job. After that, the actual dialog box for 
saving the job will open and you will be required to specify the file 
name and directory. 
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The Save As… Command  

With this command you can save a new file under the name you 
select in the target directory you desire. You can also use this 
command to change the file name and / or the directory of 
already existing files. 
For example, you may want to save a job composed of parts of an 
already existing job without losing the old version. Then choose 
the Save As... command and you can save the new file under a 
different name in a new directory. 
You can also use the Save As... command when you want to 
save the current file on a diskette or CD.  

The Save All Command 

This command saves all jobs open in EuroVECTOR. If there is a 
newly created job among them, you can save it under a file name 
of your choice in a selected directory. 

The Online Service… Command 

This command connects you directly to the support page of 
EUROSYSTEMS S.à.r.l. and the General Distributor RCS 
Systemsteuerungen GmbH. 
 
Note: If you have not installed a browser, a text file will be 
displayed, informing you what to do so that you can make use of 
the advantages of the online service. 
 
After registering with EUROSYSTEMS-ONLINE you have these 
additional facilities: 
 
• You can make use of our file service. 
• If you are registered, you have the possibility of importing the 

latest service releases or demo versions of our software 
products free of charge. 

• It is not necessary to state your address every time you order 
from our online shop. 

• Specialist traders and distributors have access to the 
Business Center. 

 
When you would like to download data subject to a  
charge, you must have a credit on your account with RCS-
ONLINE. 
 
You can find further detailed information about RCS-ONLINE 
under www.eurosystems.lu. 
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The Import Command 

With this command you can import artwork which is not saved in 
the EuroVECTOR JOB format  

The Export Command 

If you want to use a job in another graphics programm you must 
convert it to a different format for export. 

The Print Command  

With this command, you send the job you are working on to the 
default printer in any size you require (tiling). 
module. 

The Scan... Command 

This is the command you use to activate your scanner via the 
TWAIN Interface program. Provided your scanner comes 
equipped with this type of interface, you can address your 
scanner and control the scanning functions directly through this 
command. Please check with the scanner manufacturer to find 
out whether such an interface is available for your particular 
model. If it is not available, you can insert a command for your 
particular scanner software in the menu structure via the Tools 
menu / Insert Program. 

The Select Scanner… Command 

This command allows you to select your scanner. 

The Exit Command  

With this command you close EuroVECTOR and return to the 
Windows environment. If you have not yet saved the 
EuroVECTOR job you were 
working on, you will be prompted to do so now. 

The Job History 

This option makes it easier for you to load the last four jobs 
without having to use the directory structure.  
The four jobs last worked on appear at the end of the list in the 
File menu. Click with the mouse cursor on the name of the 
desired job. 
The selected file will then be loaded to your working area. 
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3.2 The Editing Menu  

The Undo Command  

This command makes it possible for you to undo or reverse the 
last few editing procedures you have completed. The standard or 
default setting allows for the last five steps to be reversed. You 
can increase this number in the Setup menu under 
Settings/Diverse/Number of Reversible Steps. The default 
value is designed for a computer with 8 megabytes of RAM. Only 
if your computer is equipped with more RAM do we advise an 
increase in the number or reversible steps. The maximum 
permitted is 100. 
 
Note: This setting can only be changed for a new file (File menu, 
New)! 

The Redo Command  

This command is the opposite of Undo.  
It restores the editing functions you have previously chosen to 
undo. 

The Cutting Command  

With this command you can remove objects from your working 
area and temporarily store them on your computer’s clipboard.  
This is a very convenient way to insert an object in a different 
position, in a different file or even in a different program. 
 
Note: The clipboard has only a limited capacity. If there is not 
enough storage space for the artwork or objects, use the Export 
command to move your data. 

The Copy Command  

With this command you can store items on the clipboard without 
having them removed from your working area. 

The Paste Command  

With this command you retrieve items from the clipboard and 
insert them into your job. When you activate this command, the 
cursor turns into a right angle containing the word Insert. 
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Point the tip of the right angle at the exact location where you 
would like to insert the object and press the left mouse button to 
execute the Paste command. 
Note: Only bitmaps with a color depth of max. 8 bits per pixel can 
be read back via the Windows clipboard. 

The Paste Contents... Command  

This command lets you import images to EuroVECTOR via the 
clipboard. 
 
Note: This menu item is not active when objects are copied in 
EuroVECTOR. 

The Select All Command  

With this command you can simultaneously select all objects in 
your current job, i.e. all objects inside as well as outside your 
working area. The selected objects can then be grouped, 
combined or moved. 

The Job Info… Command 

The Job Info command allows you to record additional 
information relating to each job. The information can be printed 
out and used for invoicing etc. 
 
Besides information such as Order No. and Company 
Address, the Job Info gives details of the material used. You 
can use the Memo field to record other information in note form. 

The Color Layer Box Command... 

This command opens the Layer Settings dialog box which 
allows you to color objects, specify vinyl colors, select objects of 
the same vinyl color, make layers invisible, lock layers, etc.  
 

 
 
 
 
 
 
 
 
 
 
 

 CTRL+A 
 
 
 
 
 
 
 
 
 
 
 

 CTRL+2 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

 

REFERENCE SECTION Chapter 3

91 

3.3 The Design Menu  

The Rotate Axis Command  

This command is used to rotate objects by 90°.  
You need this option regularly if you want to adjust your objects 
quickly to the running direction of the vinyl without performing the 
Rotate command. 
 
Note: The A key also performs this operation..  

The Horizontal (X) Mirror Command  

This command mirrors a selected object on an imaginary 
horizontal axis through its center point. If you select several 
objects, they will be mirrored around an imaginary horizontal axis 
located in the middle of the selection box indicated by the eight 
black squares. If you have not selected any objects, your entire 
design (all  objects) will be mirrored horizontally. 

The Vertical (Y) Mirror Command 

This command mirrors a selected object on an imaginary 
horizontal axis through its center point. If you select several 
objects, they will be mirrored around an imaginary horizontal axis 
located in the middle of the selection box indicated by the eight 
black squares. If you have not selected any objects, your entire 
design (all  objects) will be mirrored horizontally. 

The Delete Command  

On your keyboard you will find a key labeled DEL or delete. The 
DELETE key is used to permanently remove selected objects 
from your design. The objects that you want to remove have to be 
selected first.  

The Duplicate Command  

Click with your left mouse button on the Duplicate command or 
execute it via the CTRL+D shortcut. The previously selected 
object or objects will now be duplicated. The duplicated objects 
are positioned according to the values entered in the Setup 
dialog box accessible from the Settings/Diverse menu.  
 
Note: You can also duplicate objects in your design simply by 
using your mouse. Select the object(s) first. Drag the object(s) to 
the location where you would like to have it/them duplicated.  
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Without releasing the mouse button, click once with the other 
mouse button and the selected object will be automatically 
duplicated. 

The Clone Command 

You must select the object to be cloned first. Then click on the 
Clone command with the left mouse button. 
 
When you clone an object, you create a copy linked to the object. 
Any changes made to the original object will automatically be 
made to the clone as well. 
 
If the size or shape of the clone is changed it becomes an 
original object again. 

The Group Command  

With this command you can group several objects so they can be 
selected and manipulated as a single object. This is particularly 
useful when you are trying to move several objects at once 
without changing their positions relative to each other. Be sure to 
select the objects first, then activate the Group command and 
move this newly formed group of objects to the desired location. 
It is now no longer possible to manipulate the objects within the 
group individually. 
If you need to do so, please see the Ungroup command 
described below.  
 
Note: It is not possible to edit grouped objects with the  node-
editing tool. Before editing you must ungroup the objects. The 
grouped objects are shown with a dotted blue line to distinguish 
them from the ungrouped objects. 

The Ungroup Command  

This command is used to reverse the Group command, i.e. it 
separates objects that were previously grouped. The objects can 
now be selected and manipulated as individual objects. 

The Combine Command  

Similar to the Group command, the Combine command also 
converts several individual objects into one single object.  
The main difference is that with the Combine command 
EuroVECTOR ceases to regard these objects as a group of 
individual objects with their own set of attributes, such as color 
layers, etc..  
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Consider the following example:  
You have created two squares with different color layers, one 
somewhat smaller than the other. Now you place the smaller 
square in the center of the larger one. Select both objects and 
execute the Combine command. The two squares are combined 
into a single object with only one color layer (the one assigned to 
the larger square). The larger square is recognized as the outer 
contour, while the smaller square inside forms the inner contour 
of the new object. The space between the two contours is filled 
with the color selected from the layer box. A hole the size of the 
smaller square remains in the center. 

The Break Apart Command 

With this command you undo the Combine command described 
above, i.e. the objects that were previously combined can once 
again be selected and manipulated as individual objects. 

The Fill Tool 

This command assigns fills to vector objects and text strings. 

The Without Command 

This commands deletes all fills or fill bitmaps from the selected 
object. Only the wireframes of the objects remains in the 
previously assigned layer color. 

The Fountain Fill... Command 

This command opens a dialog box where you can specify the 
appearance of fountain fills, closed curves, text strings or 
combinations. 

The Bitmap... Command 

If you click this button a dialog box opens for filling objects with 
bitmaps. 
A large number of commands are available for editing bitmap fills. 

The Layer Color... Command 

This command deletes all fills of the selected object and shows it 
in the layer color in which it was created. 

The Edit Wireframe Command 

This command allows to give objects pencil attributes, create 
hairlines and delete pencil attributes. 
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The Without Command 

This command deletes all pencil attributes of the selected object 
and shows it in the layer color in which it was created. 

The Hairline Command 

This command assigns the selected a hairline in the currently 
active layer color. 

The Pencil Attributes Tool 

The Pencil Attributes dialog box allows you to design the 
outlining pencil for curves, combinations or text strings. 
Outlining pencils are used to draw the object outline in the Full 
Surface or Preview modes. 
 
Note: The pencil attributes do not affect the representation of the 
object in the wireframe mode (F9). Here the contours of the 
objects are drawn with simple outlines in the layer color. 

The Mask Bitmap Command  

This command fills an object or a combination with an underlying 
bitmap. 
First move the object to the required location above the bitmap. 
Then select the bitmap and the object to be filled and click Mask 
Bitmap. 

The Perspective Command  

This command is used to create special visual effects. Different 
perspectives can be created based on one or two points. With 
single-point perspectives, a three-dimensional effect is created by 
shortening the object. This makes the shorter side appear to be 
in the background. By shortening two sides, the objects can be 
further distorted.  

New Perspective 

Once you have activated the Perspective command, the 
selected object is given a frame with handles for you to 
manipulate. Select any one of these handles (this will make the 
marker appear black to indicate selection) and drag it to the 
desired location to change the perspective.  
 
As long as the Perspective option is active, the objects selected 
for this editing function will appear with a dotted blue outline. 
Other functions, such as Envelope, cannot be activated as long 
as your objects are in the Perspective mode.  
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To see whether the new perspective you have created is 
satisfactory, use the Lock Perspective command described 
below. All objects are now released from the perspective mode 
and can be further edited as desired. 
 
Note: By pressing the SPACE BAR once or with the node-
editing tool, the perspective can be further modified. However, 
once you have activated the Lock Perspective command, this is 
no longer possible. 

Lock Perspective  

Once you decide that the perspective you have chosen is 
acceptable, activate this command to continue editing the objects 
in the Perspective group. 

Cancel Perspective  

This command restores the objects to their original perspective, 
i.e. to the state prior to your changing the perspective or to the 
most recently locked perspective. You may also use the Undo 
command to reverse a perspective.  

The Envelope Command 

With this command you can also create some very interesting 
effects. By changing the shape of an envelope  that surrounds 
previously selected objects, you simultaneously distort its 
contents, no matter whether they are text or graphics or a 
combination of both. It is easiest to imagine the envelope and its 
contents as a rubbery mass, capable of distortion in any possible 
direction. There are four available envelope options. The first 
three (straight line, arc, curve) are basic options that can be 
applied to one or more of your object(s). The distortion created 
by these options remains regular. The fourth option gives you 
complete freedom to distort the envelope to any shape 
imaginable. 
 
Note: By pressing the SHIFT key, you can select several handles 
and them move them simultaneously.  
 
The same can be achieved with the Framing function,, i.e. by 
pulling a frame around the handles you wish to select.  
 
Selected handles or markers turn black to distinguish them from 
non-selected handles. 
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New Envelope 

With this option you can assign selected objects an additional 
envelope, which offers even greater creative possibilities. 

Lock Envelope 

Select this option when you are satisfied with the shape of the 
envelope and would like to continue editing the objects it 
contains. 

Cancel Envelope 

This command restores the objects to their original state, i.e. prior 
to your adding and distorting an envelope or to the most recently 
locked envelope. You may also use Undo to reverse the 
Envelope command. 

The Drawing Tools  

When you select this function, a flyout menu appears which 
combines all basic EuroVECTOR tools for designing graphics.  
All the tools can be activated via the toolbox or in the Design 
menu, Drawing Tools. 

The Line Mode 

The Line command activates the mode for drawing straight lines. 
The cursor takes on the shape of a cross-hair with a vector beside 
it.  
 
There are two possibilities for drawing lines: 
 
1. “Closed” lines 
You can create closed lines by holding down the left mouse 
button while drawing. You end the line by releasing the left 
mouse button. 
When the mouse cursor is located above the end of a line, this 
point is emphasized and the mouse cursor changes shape. The 
point is initialized if you click once on it with the left mouse 
button. You can continue drawing in one of the following four 
modes: Draw, Arc, Digi, Freehand. 
 
2. “Open” lines 
You can create open lines by clicking once on the left mouse 
button before drawing the lines. After that, you can draw the line 
as you wish. If you click again on the left mouse button, this part 
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line is ended and a new one can be drawn. You exit this mode by 
double-clicking on the left mouse button. 
When the mouse cursor is located above the end of a line, this 
point is emphasized and the mouse cursor changes shape. The 
point is initialized if you click once on it with the left mouse 
button. You can continue drawing in one of the following four 
modes: Draw, Arc, Digi, Freehand. 
 
Note: EuroVECTOR provides the following two design aids for 
drawing straight lines. By pressing the SHIFT key while moving 
from the starting point to the end point of your line, you can draw 
lines that are either perfectly horizontal or vertical, depending on 
the direction in which you are moving. If you press the CTRL key 
while drawing the line, the angle of the line is limited to 15° 
increments to the border of your working area, i.e. to 15°, 30°, 
45°, etc.  

The Arc Mode 

You activate the Arc mode by clicking on the right mouse key in 
the Line mode and selecting the Arc command. 
When drawing an arc, after you have fixed the second point of the 
curve, the curve will be drawn through the first, second and 
current cursor points. A click on the left mouse button creates the 
arc. 
 
When the mouse cursor is located above the end of an arc, this 
point is emphasized and the mouse cursor changes shape. The 
point is initialized if you click once on it with the left mouse 
button. You can continue drawing in one of the following four 
modes: Draw, Arc, Digi, Freehand. 

The Rectangle Mode 

This command is used to activate the rectangle-drawing mode. 
You may also select this mode by clicking on the Pencil icon in 
your tool box and choosing the Rectangle icon in the flyout box. 
Once you have selected it, move your cursor (which has taken on 
the shape of a cross-hair with a small rectangle beside it) to any 
of the corners of the rectangle you intend to draw. 
 
Press your left mouse button, and continue to hold it down. Draw 
a rectangle by moving the cursor to the diagonally opposed 
corner. Once you release the mouse button, the rectangle is 
drawn for you.  
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Note: EuroVECTOR provides the following design aids for 
drawing rectangles. By pressing the SHIFT key while drawing the 
rectangle, the selected point of origin of your rectangle will 
actually be its center point.  
If you press the CTRL key while drawing the rectangle, 
EuroVECTOR will draw a perfect square. If you press both the 
SHIFT and the CTRL key simultaneously while drawing the 
rectangle, EuroVECTOR will draw a square that is perfectly 
centered.  
The status of these keys (pressed or unpressed) while releasing 
the left mouse button determines how the square will be drawn. 

The Circle Mode 

This command is used to activate the Circle and Ellipse modes. 
You may also select this mode by clicking on the Pencil icon in 
your tool box and choosing the circle icon in the flyout box. 
In this mode you pull up a box into which the ellipse is fitted. 
Thus, first click with the mouse on one corner of the box. 
 
Note: The starting point on which you click to begin the drawing 
procedure is not on the ellipse but constitutes the corner point of 
an imaginary box containing the circle or ellipse. By pressing the 
SHIFT key while dragging the circle or ellipse, the selected point 
of origin will actually be the center point of the circle/ellipse. If 
you press the CTRL key while opening the box, EuroVECTOR will 
draw a circle. If you press both the SHIFT and the CTRL keys 
simultaneously while dragging the circle/ellipse, EuroVECTOR 
will draw a circle that is perfectly centered.  

The Digitizing Mode 

This command activates the mode for digitizing bitmaps.  
The processing of your bitmaps will be considerably easier if you 
simply switch between the Line, Arc, Digi or Freehand modes 
by clicking on the right mouse button, pressing the arrow keys on 
your keyboard or via the toolbox. 
 
Arrow key functions: left " Line mode 
 right " Arc mode 
 up " Freehand mode 
 down " Digitizing mode 
 
If you have drawn open contours, you can close them by clicking 
on the right mouse button and selecting Close. 
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Note: Using this method, you can close all objects drawn 
regardless of the distance between the starting point of the 
object first drawn and the end point of the object last drawn. 
Another possibility of closing open contours you have drawn is as 
follows: 
 
Draw an open object. Using the mouse, move the end point of the 
object last drawn near to the starting point of the object first 
drawn. 
 
You will see that the mouse cursor has changed its shape, If you 
release the mouse at this point, the contour will be closed. 
 
When the mouse cursor is located above the end of a digi 
curve/line, this point is emphasized and the mouse cursor 
changes shape. The point is initialized if you click once on it with 
the left mouse button. . You can continue drawing in one of the 
following four modes: Draw, Arc, Digi, Freehand. 

The Freehand Drawing Mode 

This command activates the mode for drawing lines, curves or 
objects in any way you wish. 
 
Hold down the mouse button and create the object of your 
choice. Release the mouse button when the object is finished. 
When the mouse cursor is located above the end of a digi 
curve/line, this point is emphasized and the mouse cursor 
changes shape.  
The point is initialized if you click once on it with the left mouse 
button. You can continue drawing in one of the following four 
modes: Draw, Arc, Digi, Freehand. 

Geometric Shapes… 

With this command you can activate the mode for drawing 
polygons and other geometric shapes such as stars. 

The Align Command 

With this command you can align two or more selected objects. 
They can be aligned horizontally or vertically. The objects can be 
centered or aligned on a particular side, at the top or at the 
bottom. If you choose to center them, they can be centered both 
horizontally and vertically. You can also have the objects arranged 
at equal distances from each other.. 
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Note: You must select a minimum of two objects to be able to 
activate this command. 

Clockwise Rotation of Objects  

This command is used to have the rotation for selected objects 
set clockwise. 
 
Note: This option is applicable only in conjunction with the 
EuroENGRAVE routing/engraving module. 

Counterclockwise Rotation of Objects 

This command is used to have the rotation for selected objects 
set counterclockwise. 
 
Note: This option is applicable only in conjunction with the 
EuroENGRAVE routing/engraving module. 

The Close Contour Command  

This command is used to close the contour of a selected object.  
The status line at the bottom of your working area indicates 
whether or not your design contains an open contour. (If it does, 
the object with the open contour will actually be counted as two!) 
Activate the Close Contour command to close the object and 
make it one. 

The Open Contour Command 

This command is used to open a closed contour of a selected 
object. 

The Round Corners Command 

With this command you can round off corners, both inside and 
outside, either for the selected nodes or entire selected objects. 
It is particularly useful for rounding lettering. 

The Delete Redundant Nodes Command 

This commands eliminates nodes which are lying directly on top 
of one another on an object. Nodes located between the ends of 
straight lines will be automatically deleted. 

The Add to Clipart Group Command 

This command adds a selected object to the clipart group which 
is currently active. The background appears in gray if no object is 
selected. 
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The Object Attributes Command 

This command opens a dialog box displaying the attributes of 
one selected object. If more than one object is selected, the 
coordinates of the bounding box of these objects and its center 
are shown. The number of objects is shown as the title of the 
dialog box. 
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3.4 The View Menu  

The Zoom In Command 

This command, used to magnify all or parts of your design, can 
also be activated by clicking on the Zoom icon in the tool box 
and then selecting the icon with the magnifying glass and the 
plus sign in the flyout box. Once you have activated this 
command, the cursor turns into the shape of a magnifying glass 
containing a plus sign. Using your left mouse button, you can 
select the area in your design you wish to magnify by dragging a 
box around it. Once you release the mouse button, EuroVECTOR 
zooms in on the selected area and redraws it.  
 
Note: The zoom-in procedure can be repeated several times for 
further magnification until EuroVECTOR issues an audible alert 
that indicates the maximum magnification level has been reached. 

The Zoom Out Command  

This command reduces the size of your working area step by 
step. 

The Full Page Command 

This command is used to display the working area in its entirety. 

The Show All Command 

With this command, also accessible from the tool box, i.e. the 
icon depicting a monitor in the Zoom flyout box, you can have 
EuroVECTOR display all objects in your working area. 
 
This means that the objects will be enlarged or reduced just 
enough to display everything on your screen.  
 
Note: Holding the SHIFT key down while activating this 
command will provide a full-screen display of a previously 
selected object or objects.  

The Show Selected Objects Command 

With this command you can have EuroVECTOR display only 
selected objects in your working area. You can also activate this 
command by pressing SHIFT+F4. 
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The To Front Command 

When you are working with several color layers, you can use this 
and the following commands to change their sequence. 
With the To Front command the selected object/color layer is 
moved to the very front or top. 

The To Back Command 

With this command the selected object/color layer is moved to 
the very back or bottom. 

The Forward One Command 

With this command the selected object/color layer is moved to 
the next higher color layer. 

The Back One Command 

With this command the selected object/color layer is moved to 
the next lower color layer. 

The Reverse Order Command 

With this command the sequence of objects/color layers is 
reversed. Whatever was on top is moved to the bottom, and vice 
versa. All objects or color layers in between are reversed as well. 

The Always in Front Command 

With this command the EuroVECTOR window remains 
permanently in the front.  

The Refresh Screen Command 

This command tells EuroVECTOR to redraw all objects currently 
displayed in your working area. This will eliminate any debris, 
such as excess points or lines left over from previous editing 
procedures. 
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3.5 The Tools Menu 

The Vectorizing … Function 

This command give you access to EuroVECTOR’s integrated 
vectorizing software, which converts scanned bitmaps into Bezier 
curves. 
 
Note: Bitmaps cannot be cut with a plotter since these images 
merely consist of dot patterns recognized by the scanner. Such 
pixel graphics must first be converted to vector graphics for 
output to a cutter. 

The Revectorizing Option 

This option considerably speeds up the vectorizing process. It is 
very useful for determining the best parameters for vectorizing. 
When repeating the vectorization, an internally created bitmap is 
used rather than the original bitmap in your working area.  
 
Note: If you have saved any changes to the original bitmap in 
your working area, you will have to use the Vectorizing rather 
than the Revectorizing command. 

The With Color Assignment Command 

This menu item can be turned on and off at will. As a default it is 
turned off. 

The Contour Line... Tool  

This command provides a number of selected objects with an 
outline. 
Unlike the Outline command, this tool can also be used to 
provide bitmaps with outlines. Instead of individual objects being 
outlined, if possible an outline is created to encompass all the 
selected objects. Therefore the function is particularly useful for 
creating cutting lines for stickers. The objects for the sticker can 
be put together as you wish. The outline is then created at 
whatever distance you wish from the objects. It can later be used 
for cutting out the printed sticker. 

The Clipart Manager Command 

This command launches the clipart manager. Use your left mouse 
button to click on the Group: field or on the button at the end of 
the text field to activate the list of all available categories.  
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Select one of them. If you wish to add one or several objects to 
this group, select them in your working area, then click on the 
Add icon. Repeat this procedure until you have filled the category 
with all the desired symbols. 
 
Note: If you click on a piece of clipart with the right mouse 
button, a dialog box will be opened in which you can enter clipart 
signatures. The maximum text length is 20 characters. 
 
There are two possibilities for importing clipart into your working 
area: 
 
1. Position your cursor on the piece of clipart you wish to 

import. A black frame is drawn around a piece of clipart 
which has been selected. If you double-click with the left 
mouse button, the piece of clipart art will be imported to 
EuroVECTOR and positioned so that the lower left corner 
of the job is located on the point of origin (0/0) in your 
working area.  

 
2. Drag & drop: Position your cursor on the piece of clipart 

you wish to import. A black frame is drawn around a piece of 
clipart which has been selected. Press the left mouse button 
and keep it held down so that you can drag the selected 
piece of clipart directly to EuroVECTOR. 

 
You can delete clipart which you no longer require from the 
clipart manager by clicking the Delete button. 
If you want to create a new clipart group, enter the group name in 
the New Name box.  
 
The Create Group button creates a group of this name. 
 
EuroVECTOR jobs can be saved as symbol files under the group 
name thus defined. The group can be filled with the Add button 
in the Clipart Manager. 
 
The Import Group button allows you to import groups of clipart. 
The file ending is *.cla. Groups can be deleted or renamed using 
the other two buttons. 
 
The Back button closes the Clipart Manager. 
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The Add Program …Command 

With this command you can insert a different program (unrelated 
to EuroVECTOR) into the EuroVECTOR menu structure. This 
keeps the user from having to exit EuroVECTOR to launch other 
programs and also from going through the Windows program 
manager to do so. 

The Edit Program List...Command 

With this command you can edit insertions you have made in the 
EuroVECTOR menu structure. 
 
Note: This command only applies to menu items related to other 
programs added in by the user (See Insert Program ... 
command above.) 

The Measuring Tool 

The measuring tool is used to perform measurements (between 
any two points) in your design. As soon as you click on the 
Measure icon in your tool box, the cursor changes into a bull’s 
eye. Move the center of the bull’s eye to the first point, i.e. the 
point from which you intend to measure.  
While holding down the left mouse button, drag the bull’s eye to 
the second point, i.e. the end-point of the distance you are 
measuring. A guideline provides a visual connection  
between the two points. 
If you hold down the SHIFT key during this procedure, the 
measuring can be limited in a horizontal or vertical direction. This 
makes it easier to measure straight lines accurately. 
 
Note: All objects are resized proportionally. When bitmaps are 
rotated, the bitmaps are also enlarged but not the objects shown 
in the bitmaps. 
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3.6 The Image Menu 

The Image menu contains a number of functions used for editing 
images and photographs.  

The Reduce Colors …Command  

 

Fig. 88: Dialog Box for Color Reduction Settings 

This option is used to reduce the number of colors in a scanned 
image which may contain thousands or even millions of colors. 
The number of colors can be set from 1 bit (2 colors) up to 24 
bits (16.7 million colors [Targa-Format]).  
 
The amount of data associated with such great color depth is 
considerable and requires a powerful computer system for 
processing. In most cases, we therefore recommend reducing 
the number of colors for a more efficient use of your computer. In 
addition, if you intend to cut the image from vinyl, only a relatively 
limited number of colors is even feasible.  
 
The color reduction can be done incrementally down to one bit 
per pixel (for black and white). Dithering is optional. 
 
Dithering refers to a process in which adjoining pixels of different 
colors are colored slightly differently to simulate a third color. 
With dithering, a color monitor can produce the effect of more 
than 256 colors. 
 
Note: If you intend to vectorize the image later on, do not select 
the dithering option since this will negatively affect the quality of 
vectorization. 
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The Posterize… Command 

With this command you can reduce the number of colors per 
color layer. The number of permissible colors per layer is 2 to 64.  

The Grayscale... Command 

Select this command to convert a color image to grayscale with a 
maximum of 256 levels. 

The Invert... Command 

With this command you can convert a positive scanned image to 
a negative and vice versa. The color value for each pixel is 
replaced by its opposite value in a color scale, e.g. 0 becomes 
255, 50 becomes 205. 

The Contrast…Command 

This command is used to adjust the contrast in the scanned 
image. The contrast between the lighter, darker or intermediate 
areas can be made more pronounced or softened. 

The Blend Command 

Nice effects can be obtained with this command. You cannot 
perform this command unless two images are selected in your 
working area.  
The two images are merged. The best effects are obtained when, 
for example, a fountain fill running from light to dark in a matching 
color is integrated into a company logo in a contrasting color. 

The Contrast…Command 

This command is used to adjust the contrast in the scanned 
image. The contrast between the lighter, darker or intermediate 
areas can be made more pronounced or softened. 

The Brightness... Command 

This command governs the brightness of the entire scanned 
image. Brightness consists of the intensity of light which is 
reflected or absorbed by the image. 

The Saturation... Command 

With this command you can adjust the intensity of your colors or 
hues. 
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The Sharpness... Command 

This function enhances the sharpness of pixels in bitmaps by first 
localizing the edges of pixels and then setting the degree of 
tolerance for the background pixels via the filters (values between 
-100 % and +100 % are possible). 
 
Result: The contrast of the edges (adjacent pixels) is enhanced. 

The Gamma Correction… Command 

Gamma correction is a method of adjusting color gradation, 
taking account of how the eye perceives a color when the 
adjoining area is of a different color. 
Gamma correction primarily affects color hues in the center of 
the spectrum. 
Gamma values between 0.01 and 4.99 can be set using a filter. 
 
Result: By adjusting the gamma value, you can achieve a greater 
contrast between details in drawings. 

The Relief…Command 

With this filter, you can create a relief or three-dimensional effect 
in your image. This means that certain areas will appear raised 
while others are lowered. This effect can be altered by selecting 
different origins. 

The Convert to Bitmap Command 

With this command you can convert all selected objects to a 
bitmap with user-definable resolution and color depth. 

The Cut Section Command 

This command is very useful for vectorizing single sections of 
your graphics. You are working on a bitmap and only want to use 
the lettering for further editing. Place an object, e.g. a circle or a 
rectangle (any shape is possible) over the part of the bitmap 
which you need. 
 
Select both objects, perform the Cut Section command and 
drag the object you need to the desired position in your working 
area. 
The object is now available for you to continue working on it.  
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The Properties…Command 

This command lets you increase the number of pixels in an image. 
Increasing the number of pixels results in the image increasing in 
size accordingly. 
The resolution is indicated in DPI (dots per inch). 
This menu item also provides additional information about the 
bitmap. The Storage Space required by the bitmap in the 
working storage and the Color Depth used are shown. 

Transparent Display of Images in Wireframe 
Mode 

In the Wireframe Mode you have two options for displaying your 
images: transparent or full surface. Select Properties in the 
Image menu. 
 
The following dialog box is opened: 
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Fig. 89: Dialog Box for Setting Bitmap Properties 

You will see the option Transparent Display in Wireframe 
Mode in the lower part of the dialog box. This is the default 
option which is normally turned on. 
 
Advantage: Bitmaps can be positioned exactly in the wireframe 
mode (see example below). 
 
Wireframe mode  Wireframe mode 
transparent display  transparent display 
not active  active 
 

 

Fig. 90: Example of Transparent Display 

You can see on the left side of the example in the above 
illustration that the images lying beneath the bitmap cannot be 
seen or can only partly be seen. 
 
On the other hand, all the objects on the left side can be seen 
and can therefore be positioned well. 
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3.8 The Settings Menu  

The Settings menu is used to select basic setups for default 
values for working with EuroVECTOR. There is a dialog box 
available to the user for each basic setting (e.g. Diverse, Job Info). 

The Basic Settings ... Option 

Diverse... 

You have a choice of the following default settings: 
 
Duplicated Values 
 
X Offset 
You can enter the distance you wish to have between the 
horizontal duplicates in this box.  
Y Offset 
You can enter the distance you wish to have between the vertical 
duplicates in this box. 
 
Move Objects 
Increments in X Direction 
With this entry you can determine the incremental distance a 
selected object moves vertically when you press the arrow keys 
on your keyboard. 
 
Increments in Y Direction 
With this entry you can determine the incremental distance a 
selected object moves vertically when you press the arrow keys 
on your keyboard. If you later decide that you want to move 
objects in smaller increments than you have indicated here, you 
have the possibility of reducing the increments as follows: 
 
Note:  Pressing the SHIFT key while using the arrow keys 
reduces the increments to one tenth of the original value.  
Pressing SHIFT + CTRL while using the arrow keys reduces the 
increments to one hundredth of the original value. 
 
Autosave Interval 
Under Autosave Interval you can specify how frequently (in 
minutes) you want EuroVECTOR to automatically save the curent 
job or file on your hard disk. The Save file is always located in the 
main directory of EuroVECTOR. Its name is autosave.job. 
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Number of Reversible Steps 
This entry concerns the Undo command discussed earlier in the 
Edit Menu. 
 
No Undo/Redo for Bitmaps Exceeding ... 
For bitmaps exceeding the value entered in this field the 
Undo/Redo functions are automatically turned off, i.e. any 
changes made to these bitmaps using the Image menu cannot 
be reversed. 
 
The reason for this is that the time required for bitmaps above a 
certain size is too long, as a copy of the original has to be made 
for every undo or redo step. 
 
The value entered in this field should be between 5% and 10% of 
the RAM capacity. 
The advantage of this function is that you save time. 
Delete Undos Before Printing  
This command deletes all undos made to date. 
 
Export via Clipboard 
When exporting via the clipboard, you can automatically specify if 
objects exceeding 600 * 600mm (about 24 x 24 ins) are to be 
scaled. 

Job Info 

In addition to the fields available in Job Info, this dialog box 
allows you to generate other user-defined fields, which will be 
displayed in the loading and deleting dialog boxes when they 
contain information. 
 
If you click the Automatic Job Info Enquiry button, you will be 
automatically asked if you wish to enter job information when 
saving a new job. 

Mouse 

This is where you can assign a specific command to your right 
mouse button, which will then be activated with a single click. 
Display the list of available functions by clicking on the arrow next 
to the list box. Double-click on the command you wish to assign. 
 
Node Selection Delay:  
With entries for X and Y, you can specify the number of 
increments an object will move when you drag it with your mouse. 
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The default value is 100 and the given unit of measurement is 
one thousandth. 
 
The higher the amount is, the longer it takes for the object to 
follow the mouse cursor.  Accidentally moving the objects is thus 
ruled out.  
 
Note: if you are not used to working with a mouse, it may be 
better to select a high value. 

Fill Lines 

When you add a fill line via the right mouse menu, the object 
contour will be opened and the fill line added at the point where 
you click with the mouse. 
 
Note: This command is only available in the node editing mode. 
 
Filter 
This dialog box allows you to define the search paths for 
importing and the file names for importing files automatically. 
 
Autoimport works as follows: 
 
When EuroVECTOR is loaded and an EPS file is saved in one of 
the search paths indicated under the defined name 
(EuroVECTOR), EuroVECTOR is automatically started and the 
file will be loaded directly to your working area. 
 
There is an automatic feature called CoRUN for importing data 
from CorelDRAW 3-11. You can find further information about 
CoRUN autoexport at the beginning of this manual 
 
Preferred filters: 
The following choice of filters is available: 
 
*.EPS AI Illustrator, EPS incl. *.EPS 
*.AI AI Illustrator, EPS, AI Postscript 
*.BMP EuroPhotoCUT, Windows bitmap 
*.PCX EuroPhotoCUT, Paintbrush bitmap 
 
Note: The settings must be made in the Preferred Import Filter 
boxes before files can be imported to EuroVECTOR with drag & 
drop. 
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Turn Off Preview For... 
Here you can make settings for the bitmap or EPS file preview in 
the Import dialog box.  
If, for example, you enter an amount of 2MB in the Bitmaps 
Larger Than... box, the preview for bitmaps larger than 2MB will 
be automatically turned off.  
 
If you want to have the imported file displayed, you have to 
activate the Preview box below the preview window. The default 
value for this option is 1MB.  
 
Values for the EPS file preview in the Import dialog box can be 
entered in the EPS Files Larger Than... box. 0.1 MB is the 
default amount here. 

Geometric Shapes 

 

Fig. 91: Settings for Geometric Shapes 

With this command you can activate the mode for drawing 
polygons and other geometric shapes such as stars and ellipses. 
 
Example 1: Create Star From Circle 
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In the example above you can see the star that has been created 
on the left. The radius of the outer and inner circle can be seen 
on the right. A radius of 1 of 100 for the outer circle and 1 of 50 
for the inner circle were entered in the dialog box. The radius is 
half the diameter of a circle. 
 
Example: Radius / Diameter 
 

 
Example 2: Create Star From Ellipse 
 

 
 
All four radiuses are used for ellipses, as the ellipse is not a 
regular circle. The four radiuses are shown as circles in the 
example above. 

The Color Palette Command 

This command allows you to create, load or save new color 
palettes. 
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New 

This command deletes all color layers with a layer number higher 
than 6.You should use this command when you want to create a 
new color palette. 
You can select the layer color by simply clicking on the desired 
color with the left mouse button and then clicking the OK button. 

Load... 

This command is used to load previously created palettes. 

Save 

Use this command to save a newly created or modified default 
palette on your hard disk. 
 
If the new or modified palette is saved as the default palette, it will 
be used whenever EuroVECTOR is restarted. 

Save as... 

Use this command to enter the name of a new palette. 

Default 

This command loads the color palette which comes with 
EuroVECTOR as the default palette. It is made up of Mactac vinyl 
colors which have been specified as the default palette with the 
aid of the color fan. 

Palette History 

This function facilitates the loading of the last four color palettes 
without having to go indirectly through the list of directories. 
The names of the color palettes most recently worked with 
appear at the end of the list in the Color Palette menu. To open 
the palette, click with the mouse on the name of the desired 
palette. 

The Control Panel… Command 

This command activates the Control Panel option box of your 
main Windows group, located in the Windows program 
manager. You need this command to modify the system 
parameters of Windows, which is usually necessary for 
configuring the serial interface when installing a printer or plotter. 
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Working Area 

This is where you can redefine the size of your working area. 
Besides various standard settings, you can specify up to 10 user-
defined sizes. 
This is a useful function for users of routing and engraving 
machines, as they no longer need to redefine the working area 
each time. 
The color of the working area can be defined by the user, thus 
guaranteeing better layout control on the screen. 
 
Note: Double-clicking on the shading of the working area (to the 
right or along the bottom) also activates this dialog box. 

The Object Attributes Toolbar 

This item opens a dialog box in which you can add optional 
buttos to the Object Attributes toolbar. This toolbar is empty the 
first time you start EuroVECTOR. 

The Rulers... Tool 

In this dialog box you can define the location of the rulers. If you 
find you are running out of space in your working area, you may 
choose not to have the rulers displayed at all. 
With a metric ruler every fourth increment is shown as a longer 
line and with a ruler in inches every second and fourth increment. 

The Unit of Measurement Command 

This command is used to change the unit of measurement (mm, 
cm or inch). This can also be done by clicking the button located 
at the point where the horizontal and vertical scroll bars meet. 

The Grid Tool 

In the Grid Settings dialog box you can choose between 
guidelines or grid points. This function can be very useful for 
positioning objects in the working area. 
Both the grid spacing and the offset in X/Y direction can be 
defined by the user. The default reference point is 0/0 in the 
lower left corner of the working area. For additional help when 
positioning objects, select the Snap to Grid function. 

Screen Colors 

This menu item refers to the display of colors on your monitor, 
which depends on the graphics card in your computer and the 
resolution selected in the monitor driver. 
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Note: These selections in no way affect output quality. 

Spot Colors 

If your hardware has this capability, 256 spot colors (rather than 
process colors) are used for the screen colors. 

256 Color Dithering 

With this type of display, 256 process colors are used. 

Windows Dithering 

If you do not have a VGA monitor with 256-color display, only this 
option may be selected. The color display will then consist of 16 
process colors. 
 
Redrawing graphics in your working area (i.e. Refresh Screen) 
takes up the least amount of time in this mode. 

The Edit Wireframe Mode 

In this mode, only the contours or outlines of the objects in your 
design are displayed. 
 
Note: If the layer color is white, the outlines are displayed as 
dotted gray lines. 

The Interrupt Display Command 

This option, which is particularly helpful when you are working 
with complex designs, allows you to interrupt the redrawing of the 
screen at any point in order to select another menu item or tool. It 
is not necessary to wait until the screen has been redesigned. 
It is important to note that text strings may appear in simplified 
form as crossed rectangles. This operation is extremely rapid. 
Otherwise the blocks behave in the same way as text strings.  

The Undo/Redo Command  

This command activates and deactivates the Undo/Redo 
command.  
 
One advantage of deactivating this command is that node editing 
is faster in the case of large or numerous objects.     
When there are several editing steps, the trial phase (original 
state → editing → temporary final state) can be reversed as 
follows: 
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1. Deactivate Undo/Redo 
2. Edit objects 
3. Activate Undo/Redo 
 
You can restore the state prior to step 1 by clicking the Undo 
command in the Edit menu. 

The Cross-Hair Command 

When you have activated this option, the cursor becomes a cross-
hair (an intersecting vertical and horizontal line) that covers your 
entire working area. As soon as you go beyond the working area, 
e.g. to select a tool, the cursor reverts back to the arrow shape.  

The Snap to Guideline Command 

This option is designed to help you precisely position objects on 
any guidelines you may have placed in your design. In this mode, 
objects will gravitate towards the nearest guideline. 

The Guidelines Setup Command 

This command is used to place dotted blue guidelines anywhere 
in your design to facilitate the design, positioning, and alignment 
of objects. These lines are design aids only and will not show up 
anywhere in your output. 
 
Note: Activating the Snap To Guideline command (see above) 
will cause the guidelines to attract objects placed near them, 
which makes it even easier to precisely position objects in your 
design. 

The Lock Guidelines Command 

With this command you can lock your guidelines so that they can 
no longer be selected, moved, or deleted. 
To unlock them, you must first click on this command again. 

The Show Guidelines Command 

With this command you can make the guidelines invisible. To 
make them visible, click on this command again. 

The Select Language...Command 

If you activate this command, a dialog box for selecting the 
language opens. 
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3.9 The Window Menu 

The New Window Command 

This command opens a new EuroVECTOR window. 

The Horizontal Tiling Command 

If you perform this command, all the windows are displayed as 
follows: 
 

 

The Overlapping Command 

If you perform this command, all the windows are displayed as 
follows: 
 

 

The Close Command 

This command closes the currently active window after asking if 
you really wish to do this. 
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The Close All Command 

This command closes all open windows after asking if you really 
wish to do this. 

The Default Command 

This command activates the EuroVECTOR default toolbar. 

Color Layerbox Command 

This command activates or disables the EuroVECTOR Color 
Layerbox. 

The Setup Command 

This command turns the Setup toolbar on your desktop on and 
off.  

The Tools Command 

This command furns the EuroVECTOR toolbar on and off. 

The Node Editing Command 

This command turns the Node Editing toolbar on your desktop on 
and off.  

The Object Attributes Command 

This command turns the EuroVECTOR Object Attributes 
toolbar on and off. 

The Object Info Status Bar Command 

This command turns the EuroVECTOR Object Info status bar on 
and off. 

The Element Info Status Bar Command 

This command turns the EuroVECTOR Element Info status bar 
on and off. 

The Clipart Command 

This command turns the Clipart  toolbar on your desktop on and 
off. 

The Job History Command 

All the active jobs are listed in this part of the window. If more 
than 9 jobs are open, they are shown under the menu item 
Further Windows. 
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3.10 The Help Menu  

About… 

Clicking on About... will activate an information panel containing 
pertinent information on EuroVECTOR, such as the serial 
number, version number, free disk space, the processor and 
coprocessor. 
In the lower right part of the dialog box there is a scroll window 
listing all program files in the version you are using. You can print 
this list by pressing the Print button. 
 
Note: It will help our support staff to rapidly eliminate any 
problems you may encounter with your EuroVECTOR version if 
you give them this list. 

Help... 

This command launches the EuroVECTOR online help. 

Info…  

This window contains information on the objects in your working 
area, such as total number of objects, number of objects 
selected, text strings, data blocks and bitmaps. 

Online Support  

In RCS-ONLINE you will find useful tips and tricks about EURO-
SYSTEMS products and also questions frequently asked about 
software and various cutting plotters. To enable us to eliminate 
problems as rapidly and efficiently as possible, we would ask you 
to immediately fill out the fields in the form under Software 
Registration if you are not registered with us. 
 
In RCS ONLINE you will find useful tips and tricks about 
EUROSYSTEMS products and also questions frequently asked 
about software and various cutting plotters. To enable us to 
eliminate problems as rapidly and efficiently as possible, we 
would ask you to immediately fill out the fields in the form under 
Software Registration if you are not registered with us.  
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3.11 The Right Mouse Button Commands 

The functions of the right mouse button make working with 
EuroVECTOR much easier and faster. 
The following basic menu items are available to you: 
 

 

Fig. 92: The Object-Sensitive Menu (no object in working  area) 

When there are several objects in the EuroVECTOR working 
area, the menu appears as follows: 
 

 

Fig. 93: The Object-Sensitive Menu (at least one object in working 
area) 
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Glossary 

Terms printed in italics refer to additional glossary entries 
 
Additive Color System System based on mixing the 

additive colors of the luminous 
spectral colors red, green and 
blue (RGB), e.g. in color TVs or 
color monitors. 

 
Application Tape Tape used to transfer cut and 

weeded vinyl graphics to a 
substrate. The tape’s adhesion 
must be sufficient to hold even the 
tiniest letters while releasing them 
easily upon application. 

 
Ascender The part of a lower-case letter (e.g. 

b) that extends above the main 
body of the letter. 

 
Baseline Imaginary line on which all 

characters are placed in a line of 
text regardless of point size (with 
the exception of descenders). 

 
Bit Depth Mathematically possible number 

of colors for a given number of 
bits, e.g.: 1-bit color depth = 21 = 2 
possible colors (black/white) 8-bit 
color depth = 28 = 256 possible 
colors/graytones 24-bit color 
depth = 224 = 16.8 m possible 
colors 

 
Byte Smallest addressable unit in the 

computer memory, consisting of 8 
bits. 

 
Calibration Adjustment of printer, screen or 

adjustment to desired values 
 
Clipboard An area in your computer’s 

memory used for temporary 
storage of data that was cut or  
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 copied. This data can be pasted 
from the clipboard into any file. 
This feature thus provides an easy 
way to transfer data from one 
program to another. 

 
CMYC Cyan, magenta, yellow, contrast 

(black). Standard colors for four-
color printing. 

 
 
CMYC Color Area Total amount of all colors 

represented by the CMYC colors 
used for printing. 

 
Color Depth The number of possible color 

tones that can be recognized by a 
scanner or reproduced on a color 
monitor. 

 
Contrast Difference between light and dark 

parts of an image. 
 
Descender The part of a lower-case letter (e.g. 

g) that extends below the main 
body of the letter. 

 
Desktop Space surrounding the working 

area on the computer screen, 
containing a variety of tools. 

Digitize  To put an original image into 
digital form, either by entering 
points or lines through a digitizing 
table, or by using a scanner. 

 
Download  To retrieve programs or data via 

modem from an electronic mailbox 
and load them into your computer. 

 
EPS, EPSF  Acronym for Encapsulated 

Postscript Format. File format in 
which text and image data are 
stored in postscript format.  
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  This format includes text and 
raster data as well as bitmaps for 
displaying it on screen. 

 
Group Combining a number of objects in 

a group. Once objects are 
grouped, the positions of the 
objects relative to each other 
remain unchanged. 

 
Gamma Correction Method of adjusting color 

graduation taking into account 
how colors are perceived by the 
human eye when there are two 
adjoining areas of different colors. 

 
Group Combining a number of objects in 

a group. Once objects are 
grouped, the positions of the 
objects relative to each other 
remain unchanged. 

 
Guidelines Lines used as visual aids for 

positioning objects in the working 
area. Guidelines are onbly visible 
on the screen and are never 
plotted/cut or printed out. 

 
Halftone Image Designates an image that contains 

various shades of gray or of color. 
The shades between pure white 
and pure black are called 
halftones. 

 
Insertion Point Designates the blinking vertical 

line in a text box that can be 
edited. 

 
Justification The alignment of a text string in 

the working area, either along the 
left margin, right margin, or 
centered between the margins. 
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 In addition, EuroVECTOR offers 
the following options: block or 
forced block and adjustment of 
cap height. 

 
Laminate Cover with transparent plastic film.  
 
Overfill A narrow overlapping area at the 

edges of areas of color which are 
positioned over each other. This 
ensures that there are no streaks 
at the boundaries. The overlap can 
be created by using an overfill or 
an underfill. 

 
Point Unit of measure equal to 

approximately 1/72 of an inch 
used to measure printing type. In-
cluded in the measurement are 
ascenders and descenders as 
well as a certain space above and 
below the character. 

 
Process Colors Scale of colors for four-color 

printing with cyan, yellow, magenta 
and black (key); it is possible to 
print any color by mixing these 
colors. 

 
Resolution The amount of detail in an image 

as measured in dots or pixels per 
unit (e.g. dots per inch or dpi). 
Laser printers generally have a 
resolution of 300 to 600 dpi. 

 
Scanning Resolution Resolution for scanning analog 

images.  
 Formula: Resolution (in dpi) = 

printing length (L/cm) x 2 (quality 
factor) x enlargement factor x 2.54 
(for converting mm to in). 

 
Streaks Cracks at the boundaries of 

overlapping or adjoining areas of 
color or vinyl. 
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 They are especially detrimental in 
screen-printing or printing. 

 
Upload To send files and programs via a 

modem from your computer into 
an electronic mailbox system. 

 
Vinyl Generally, two types of vinyl are 

available, calendared and cast. 
Cast vinyl is not stretched during 
the production process and is 
therefore less prone to shrinkage. 
Cast vinyl is generally more costly 
than calendared vinyl which tends 
to have less durability and a 
greater tendency to shrink.  

 
 Vinyl materials used for cutting 

generally consist of three layers: 
 
 1. Liner (the bottom layer) 
 2. Adhesive layer in between the 

  liner and the vinyl 
 3. Vinyl material 
  
Weeding   The act of removing excess vinyl 

around cut graphics. 
 
X Height  The height (measured from the 

baseline) of a lower-case “x”, i.e. 
any lower-case letter without 
ascender, in a particular font. 
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Index 

A 

Adapt  45 
Add Used Bitmap Fill  34 
Adjust Curves  66 
Align  102 
Autosave Intervall  117 

B 

Bitmap Export Filter  80 
Bitmap Fill  32 
BMP Outline  66 
Brightness  113 

C 

Circle  101 
Clipart  109 
Clockwise Rotation of Objects  103 
Close Contour  103 
CMX-Import  78 
Color Layer Box  92 
Color Palette  122 
Contour Line  61, 108 
Contrast  112 
Convert to Bitmap  113 
Copy  91 
Corner Points  12 
Counter-Clockwise Rotation of Objects  103 
Cursorform  8 
Cusp  16 

D 

Deavtivate Tile  57 
Delete  93 
Draw  99 
Duplicate  93 

E 

Edit Program List  110 
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Ellipse  101 
Envelope  97 
Export  79, 89 

F 

Fill Tool  95 
Filltool  27 
Filter Contours  65 
Forward One   
Fountain Fill  95 
Full Page   

G 

Gamma correction  113 
Gradient  30 
Group  94 

H 

Hairline  37, 96 

I 

Import  77, 89 
Insert  92 
Insert Program  110 
Invert...  112 
Invisible  42 

J 

Job Info  85, 92 
Job-History  90 
Join  17 

L 

Last Version  87 
Layerbox  7, 39 
Line  99 
Line Thickness  37 
Lineale  123 

M 

Magnifying glass   
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Mask Bitmap  96 
Measure  26, 110 
Mouse  118 

O 

Online-Service  88 
Open  87 

P 

Palette History  123 
Paletten-Historie  40 
Paste Contents  92 
Pencil Attributes  36 
Perspective  96 
Posterize  112 
Print  89 
Print Help Lines  49 

R 

Redo  91 
Reduce Colors  111 
Reduce Tangential Points  65 
Reference-Job  84 
Refresh Screen   
Relief  113 
Revectorizing  108 
Rotate Axis  60, 93 
Round Corners  21, 103 

S 

Saturation  113 
Save Jobs  83 
Scale with Object  34 
Scan  89 
Seamless Tile  35 
Sharpen Corners  19 
Sharpness  113 
Smooth Curves  66 
Starting Point  12 

T 

Tangential Points  12 
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The Zoom Tool  24 
Tile  50 
TWAIN interface  64 

U 

Undo  91 
Ungroup  94 

V 

Vectorize  65 
Vectorizing   

W 

Working with Color Bitmaps  67 
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